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About this guide 

The chapters of this Guide present the following information: 

Introduction outlines the features of 1st Word Plus™ and gives you some 
advice you shou!<:J follow before you go further. 

Guided tour takes you step by step through a tutorial session using basic 1st 
Word Plus features. Beginners to word processing should follow this tutorial 
carefully before attempting the more advanced features described in later 
chapters. If you already have experience of other word processors, you can go 
straight to the next chapter. 

1st Word Plus essentials describes 'the 1st Word Plus windows, how to load 1st 
Word Plus, save your document and leave 1st Word Plus. 

Editing documents tells you how to make changes to the text of documents, 
check them for spelling, and paste pictures into them. 

Document layout tells you how to use the formatting and style options to 
control the layout and appearance of your document. 

Printing documents explains how to get your documents onto paper. 

1st Word Plus menus is a reference section providing brief summaries of all 
the menu options used in 1st Word Plus. 

Keystroke equivalents lists all the things you can do using keystrokes instead of 
menu options. 

Introducing 1st Mail tells you how to run 1st Mail on your Acorn RISC OS 
computer, and includes a Gu ided tour using the example documents on the 
Program disc. 

More about 1st Mail provides detailed information on the production of 
formatted documents using command files and datafiles. 

About this guide 
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Conventions used in 
this Guide 

1st Mail commands is a reference chapter providing brief summaries of all the 
commands used in 1st Mail. 

The Appendix provides information on the printer drivers supplied with 1st 
Word Plus. In case you have a printer which is not yet supported by 1st 
Word Plus, it also tells you how to create your own printer driver. 

The three buttons on the mouse are (from left to right as you hold the mouse) 
Select, Menu and Adjust. All the terms for mouse actions used in this Guide -
click, double-click and drag - have their normal meanings as described in the 
User Guide. 

'Click on' is used as a shorthand for 'click Select on'. 

Sometimes you will need to carry out an action by holding down one key 
while pressing another. This is indicated as follows: 

Shift-F6. 

This example would mean 'hold down Shift, press and release F6, then 
release Shift'. 

Menu names and options appear in bold as follows: 

Style 

On the screen, a menu option that leads to a dialogue box is shown with three 
dots after its name. For the sake of readability, these dots are omitted from 
the text of this Guide. 

Text that you enter and text that appears on the screen is shown as follows: 

This text appears on screen 

About this guide 



Introduction 

Welcome to 1st Word 
Plus 

You can think of a word processor like 1st Word Plus as a friendly, but very 
powerful, typewriter. With a conventional typewriter, your text is printed on 
sheets of paper as you type it. It is possible to do a certain amount of editing 
or correcting, though of a very limited kind. Correcting fluid can be used to 
delete text, and you can type over the corrections, but you will not be able to 

insert text. Moving and copying blocks of typewritten text is also very 
difficult unless you happen to have a photocopier, scissors and a pot of glue 
handy. 

With a word processor like 1st Word Plus, however, your text is displayed 
on the screen as you type it in, instead of being printed immediately, so you 
have a 'breathing space' in which you can make as many corrections as you 
want. Moving, copying, and deleting whole sections of text is also extremely 
easy with 1st Word Plus. You need only print your text out when you are sure 
that it is just right. 

1st Word Plus allows you to 'cut and paste' sections of text both within and 
between documents, and combine them with your own graphics. There's also a 
70,000-word spelling checker and a mail merge facility. 

1st Word Plus is designed specially for Acorn RISC OS computers (such as 
the Archimedes range and A3000), so it is very easy to learn and use. Full 
advantage is taken of desktop features such as windows, icons, and menus. In 
fact, the only time you will need to use the keyboard is when you are typing 
in text. Complex editing tasks such as cut and paste, changes in layout, and 
reformatting can all be done using the mouse alone (though if you prefer 
using the keyboard, you can do that instead). 

It is also very easy to create text for importing into Acorn Desktop Publisher: 
the chapter Editing documents tells you how to do this. 

Introduction 3 
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1st Mail 

Essential reading 

Background 
requirements for 1st 
Word Plus 

If you have used 1st 
Word Plus before 

1st Mail is the mail merge program accompanying 1st Word Plus. A mail 
merge program allows you to produce a series of documents which differ 
from each other only in certain details. The classic use of this kind of program 
is to send the same letter to a number of different people. This is done by 
creating a master document with 1st Word Plus. The differing information or 
variable data, such as customer names and addresses, is saved separately. By 
merging the variable data for each customer into the master document - hence 
the name 'mail merge' - a series of personalised letters is created, although 
you have only needed to type in one. 

Before starting to use 1st Word Plus, you must read the Release Note supplied in 
the pack, especially the part relating to relocatable modules. 

You also need to be reasonably familiar with the RISC OS desktop. In 
particular, you will need to know about the different parts of the desktop, 
how to use windows in general (scrolling, moving, resizing and so on), and the 
directory displays that show you where your files are saved on disc. If 
necessary, re-read the relevant parts of the Welcome Guide or User Guide 
supplied with your computer. 

1st Word Plus requires four relocatable modules to be loaded into the 
computer; it also requires that they are of specific dates (or later). 
Relocatable modules are software extensions to the operating system; you 
don't need to know anything about them in order to use 1st Word Plus, but 
you will find more information in the chapter of your User Guide entitled 
Module-related commands. 

The modules you need are provided on the 1st Word Plus Program disc, in 
the ! System .Modules directory. Since the exact process you need to follow 
may vary in future, we have put the relevant instructions in the Release Note 
accompanying the 1st Word Plus package. 

If you are already a 1st Word Plus user, you will find that much of the 
application is familiar to you. Changes have principally been introduced to 
bring 1st Word Plus into line with other RISC OS applications; these mainly 
concern the way files are loaded and saved. However, some original features 

Introduction 



,---, Making working copies 

Installing 1st Word 
Plus on a hard disc 

of loading and saving in 1st Word Plus have been preserved for the benefit 
of users of the first release. Once you start work in your 1st Word Plus 
document window, you will find yourself in a familiar world. 

The main changes you will notice are these: 

• 1st Word Plus is now loaded by installing its icon on the icon bar. When 
you then click on the icon, a 1st Word Plus window opens on the desktop, 
instead of taking over the whole screen. 

• The keypad no longer displays the character set: to obtain 'unusual' 
characters, there is a new application, 1stChars, which is described in the 
chapter entitled Editing documents. 

• Loading and saving of documents is now done in the RISC OS manner, 
with the ususal dragging and double-clicking techniques. These are 
described in this Guide, but if you are familiar with RISC OS already, 
you will find few surprises. 

• A new feature has been introduced enabling you to change the case of 
words or sections. For example, you can change a word in upper case into 
lower case, or put all the intial letters in a group of words into upper 
case. This is described at the end of the chapter entitled Document layout. 

Before you do anything else with 1st Word Plus, you should make copies of 
the release discs and keep the originals in a safe place. To make backup 
copies, follow the instructions in the User Guide supplied with your computer. 
Use the backup copies as your working discs. 

If your computer has a hard disc, you should copy the software onto it. Do this 
using the copying facilities of the desktop, described in your User Guide. You 
can arrange the files however you like, but we recommend that you do the 
following: 

• Create a directory in a suitable place called, for instance, 1 wp. 

• Copy the contents of the distribution discs into it. 

Whenever this Guide tells you to insert the Program disc or the Utilities disc, 
all you will need is an open directory display for your 1st Word Plus 
directory. 

Introduction 5 
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Customising 1st Word 
Plus 

Monitors 

There are two features of 1st Word Plus that you can change, if you wish, by 
editing the ! Run file within the 1 stWord+ application directory. If you have 
not made changes of this sort to an application before, don't worry: you can 
leave 1st Word Plus exactly as it is, and in any case, you may prefer it that 
way! However, the changes are in fact very easy to make. They relate to the 
following features: 

• When you try to save a file by overwriting an existing file with the same 
name, you will be warned that this is what you are about to do. You will 
then need to click on the OK box to proceed. You can remove this warning 
step if you wish. 

• A file of type 'Text' can be loaded into either Edit or 1st Word Plus 
when you double-click on its icon. If both applications are running, what 
happens is unpredictable unless you tell 1st Word Plus that it should not 
load Text files. If only 1st Word Plus is running, it will ignore Text files 
unless you tell it otherwise. 

You can control these features by editing two lines m the ! Run file, as 

follows: 

1 Open the 1st Word Plus application directory by holding Shift while you 
double-click Select. Load the ! Run file into either Edit or 1st Word Plus 

by dragging its icon onto the application icon on the icon bar. 

2 To force overwriting of existing files, change no to yes in the line: 

*Set FirstWord Plus$Force0verwrite no 

3 To set 1st Word Plus to load Text files, change no to yes in the line: 

*Set FirstWord Plus$LoadTextFiles no 

Although the best screen performance is obtained when a colour monitor is 
used, you can also run 1st Word Plus with a monochrome II10nitor. However, 
some of the finer details, such as the difference between light and normal 
text, may then be less easy to see on the screen. They will, nevertheless, 
appear correctly on paper. 

Introduction 
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Guided tour 

Loading 1st Word Plus 

fUr1 ........ ....... 
f'PIZt 

If you are a complete newcomer to word processing, this chapter is designed 
to introduce you to using 1st Word Plus on your Acorn RISC OS computer. It 
will take you step by step through the fundamentals of using a word 
processor, from loading in the program to saving documents on disc. By typing 
in a sample document, you will be able to see for yourself how powerful 1st 
Word Plus is, while still being easy to use. 

If you have used other word processors before, go straight on to the next 
chapter. 

Many of the things you will be doing in this guided tour can be done in more 
than one way: one using the mouse, and one using the keyboard. To keep this 
tutorial simple, we will tell you only about one of these in this chapter. All 
the alternatives are listed in the chapter entitled Keystroke equivalents. 

If you are using 1st Word Plus from a floppy disc, insert the Program disc 
into the disc drive. Click on the floppy disc drive icon on the icon bar to open 
a directory display for the disc. If you have copied 1st Word Plus onto a hard 
disc, open a directory display for the directory containing the application. 

Double-click on the 1st Word Plus icon in the directory display. After a short 
while, the 1st Word Plus icon will appear on the icon bar at the foot of the 
screen. C lick once on this icon to open a 1st Word Plus document window. The 
screen will now look more or less like the picture over the page (the exact 
appearance of the icon bar will depend on what hardware you are using and 
which other applications- if any- are currently running). 

Guided tour 7 



1st Word Plus windows 

The document window 

The keypad window 

8 

The large empty window is the main document window. This is where you type 
your text. It is very similar to any other RISC OS window: you can move it, 
resize it, or send it to the back of the pile of windows in the normal way. It 
can also be moved almost completely off the screen to the right or downwards. 

Below the title bar, the document window has a ruler. This is used for setting 
tab positions and margins, and is described in the chapter Document layout. 

Move the pointer onto the 1st Word Plus icon on the icon bar, and press 
Menu (the middle mouse button). Move the pointer onto the Show keypad 
option, and click Select. The keypad window will appear. 

Guided tour 



1st Word Plus menus 
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The keypad has several functions : 

• The keyboard replica boxes show the effect of the function keys; there are 
also boxes representing some of the other keys such as Delete. You can 
use these just as reminders of what the keys do, or you can click on them 
to obtain the same effect as pressing the corresponding key itself. 

• A group of boxes on the left is assoc iated with printing and printers. 
These are described in the chapter Printing your document; you don't need 
to know about them now. 

• In the centre is the dictionary icon, which you will need when you want to 
check your spelling. Again, you don't need it for the time being. 

You can leave the keypad window on the screen if you want to, or close it in 
the normal way (by clicking on its Close icon). You may also find it useful to 
slide the keypad downwards, partially off the screen, so that you can just see 
the top half; this will remind you of what the function keys do. 

Pressing Menu with the pointer anywhere on the document window or the 
keypad calls up the top-level 1st Word Plus menu. This contains eight 
options, each of which leads to a submenu. To display a submenu, move the 
pointer across the arrow to the right of a menu option. In the rest of this 
Guide, we usually refer to submenus simply as 'menus'. You will not need to 
use menus until you get to the later section of this chapter which tells you how 
to edit your text. 

Guided tour 9 



Typing in text 

Bold type, capitals, 
centred text 

The following extract is the text you are going to type in; this is what it will 
look like when you've finished working on it. As you can see, it has several 
different typestyles (italic or underlined, for example), centered headings 
and numbered and indented paragraphs. These are all things which are easy 
to do in 1st Word Plus. 

BRITISH WOODLANDS 

1 . 0 Oakwoods 

There are two types of oakwood in Britain, damp oakwoods and 
dry oakwoods. The typical damp oakwood tree is the 
Pedunculate Oak with its stalked acorns and peculiar shaped 
leaves. The typical tree of the dry oakwoods is the Durmast 
or Sessile Oak in which the flowers and consequently the 
acorns have no stalks and the leaves have star-like hairs 
on their undersurfaces. 

When you open a new document window, there is a flashing block at the top 
left comer. This is the text cursor. When you type, the text will appear at the 
cursor position, pushing the cursor to the right. 

The first piece of text to be typed is the title of the extract. This is to appear 
in capital letters in emphasised or bold type and is centred on the page. 
Follow these steps: 

To type in capital letters, press the Caps Lock key at the bottom lefthand 
comer of the keyboard. A light will come on in the key and a star will 
appear next to the word 'Caps' on the keypad. 

2 To change from normal to bold type, press the function key Fl at the top 
of your keyboard. The corresponding box on the keypad will display a 
star. 

3 Now type the following text: 

BRITISH WOODLANDS 

If you make a mistake while you are typing, you can correct it easily as 
follows: 

• To delete the last character, press the Delete key. 

• To change one or more characters further back, use the cursor keys at 
the bottom of the keyboard to move the cursor until it is positioned 
after the letter(s) you want to change, and then use Delete. 

10 Guided tour 



Underlined text and tabs 

Typing ordinary text 

There is more information on making changes to your text later in this 
chapter. 

4 To centre the heading, press Fll. 

5 To move two lines down the page, press Return twice. 

6 Turn off the capitals by pressing Caps Lock again, and turn off bold by 
pressing Fl. 

Now for the numbered subheading, which introduces the use of tabs and 
underlining. To produce this, follow these steps: 

2 

3 

Type: 

1.0 

then press the Tab key. 

Typists should note that the numeric keys '1' and '0' should not be used 
interchangeably with the alphabetic keys '1' and Shift '0' as they 
sometimes are on a typewriter. 

When you press Tab, the cursor will move along the line until it is level 
with the next tab stop (marked by a diamond) on the ruler at the top of 
the window. 

To turn underlining on, press F2. 

Using Shift when a capital letter is required, type the following text: 

Oak woods 

Note: Press Shift and a character key together to type capital letters (P, C 
etc), or one of the upper or 'shifted' characters (! , " etc). If you have used 
a typewriter, you will notice that the Acorn keyboard has a Caps lock key 
instead of the typewriter shift lock. The Caps lock only shifts the letter or 
alphabetic characters. 

4 To turn underlining off, press F2 again. 

5 To move two lines down the page, press Return twice. 

Now for the easy bit. Type in the following text from the passage as you 
would on a typewriter, but without pressing Return at the end of the lines. 

Guided tour 11 



Italic underlined type 

12 

There are two types of oakwood in Britain , damp oakwoods and dry 
oakwoods. The typical damp oakwood tree is the 

Stop typing at this point. You will have noticed that the cursor automatically 
goes to the next line for you at the right time. This feature, called word wrap, 
saves you having to press Return at the end of each line. Only use Return at 
the end of a line which is to stand on its own (such as a title), or to insert 
blank lines (eg between paragraphs). 

Notice the difference in appearance between the bold type in the main 
heading and the normal type of the rest of the text. 

The next words will be underlined and in italics, so follow these steps: 

To leave a space before the next word, press the Space Bar. 

2 To turn underlining on, press F2. 

3 To turn italic on as well, press F3 . 

4 Type: 

Pedunculate Oak 

5 To turn underlining off, press F2 again. 

6 To turn italic .off, press F3 again. 

7 To leave a space before the next word, press the Space Bar. 

Continue by typing in the rest of the passage as shown below, underlining and 
putting the words 'Durmast' and 'Sessile Oak' into italics in the same way. 

with its stalked acorns and peculiar shaped leaves. The typical 
tree of the dry oakwoods is the Durmast or Sessile Oak in which 
the flowers and consequently the acorns have no stalks and the 
leaves have star-like hairs on their undersurfaces. 

T o end the paragraph you have just typed in, press Return once. 

When you have finished typing in this paragraph, your document window 
should look like this: 

Guided tour 



Correcting mistakes 

Moving the cursor 

here are two types of oakwood in Britain: daMp oakwoods and dry 
akwoods. The t~pical daMp oakwood tree is the fedunf#lafe Qak 

th its stalked acot·ns and peculiat· shaped leave~eyp1cal 
t•ee of the dry oakwoods is the PurfttR<:t or Ses<:ile faf in which 
he fl owet·s I and consequently the acot·ns I have no sa ks I and the 

ves have star-like hairs on their undersurfaces. 

We have already described how to make 'running repairs' as you type. 
However, you may not notice a mistake until you have finished , so you may 
need to move back a few lines to make the correction. To do this, you will 
need to move the cursor, the flashing block which indicates the point at which 
some text is added or altered, to the right place. 

Move the cursor by moving the pointer to where you want the cursor to go, then 
press ing Select. You can also use the cursor keys on the keyboard: 

• To move the cursor up or down one line, press i or 1. 

• T o move the cursor left or right one character, press f-or --7. 

• T o move the cursor left or right one word, press Shift-f-or Shift---7. 

• To move the cursor to the beginning or end of a line, press Control-f- or 
Control---7. 

You may find that the easiest way to get the cursor exactly where you want it 
is to move it to roughly the right place with the mouse, then move it into 
position with the cursor keys. 

Guided tour 13 



Altering text 

Tidying up paragraphs 

Indenting paragraphs 

Editing sections of text 

14 

When you have moved the cursor to the correct posltlon, you will be able to 
alter your text by deleting mistakes or inserting new text. You can delete 
single characters as follows: 

• To delete a character to the left of the cursor, press Delete or f-i. 

• To delete a character under the cursor, press Copy. 

Once you have deleted a mistake, type in any new text that is required. Notice 
how new text is inserted before the cursor, any existing text shuffling 
rightwards to make room for it. 

After you delete or insert text, the lines in a paragraph may be of uneven 
lengths and look rather untidy. To tidy up an edited paragraph, you will need 
to reformat it: 

1 Position the cursor on the first letter of the main paragraph (the 'T' of 

There). 

2 To reformat the whole paragraph, press F7. (If this causes the 
Hyphenation dialogue box to appear, click on the box in it marked 
Disable to turn hyphenation off for the present document.) 

The layout will look better if you indent the main text of the paragraph you 
have just typed in so that it appears in the same column as the text of the 
subtitle. To indent a whole paragraph, follow these steps: 

1 Position the cursor on the first letter of the main paragraph (the 'T' of 
There). 

2 To indent the first line of the paragraph as far as the first tab stop, press 
F9. 

3 Reformat the paragraph by pressing F7. 

1st Word Plus also allows you to do various things to whole portions of text 
(called selections), such as moving them, copying them, deleting them, and 
changing their style into bold, underlined, etc. Try these techniques out on the 
sample document that you have just created. 

Guided tour 



Marking a selection 

Moving your selection 

Let's mark the first sentence of the paragraph as a selection. Position the 
pointer over the first character of the selection, ie the 'T' of There, press 
Select and drag the pointer (which changes shape to a pointing hand) across 
all the text to the end of the sentence. Release Select. 

The selection is now highlighted (the text is white on a black background). 

You can move your selection to another area, such as the end of the paragraph. 
To do this: 

1 Place the cursor where you want to move the selection to - in this case the 
line below the end of the paragraph. 

2 Press Menu (the middle mouse button) and on the menu that appears, 
move the pointer over the Select option and across the arrow to its right. 
A lower-level menu or submenu appears. Move the pointer over the Move 
option and press Select. 

The selection of text you highlighted will be moved from where it was to the 
new cursor position. 

Now try moving the marked selection back to the beginning of the passage. 

Guided tour 15 
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Copying your selection 

Changing the style of a 
selection 

You can also copy or duplicate your selection, by taking the following steps: 

Highlight the selection in the usual way (as described on the previous 
page), then select Copy in the Select menu. A dialogue box will appear, 
confirming that you have now stored the selection on the clipboard. This is 
an area of memory in the computer that you cannot see, but which holds 
the selection you have copied until you are ready to use it, or until you cut 
or copy another selection. If something else was already stored on the 
clipboard, you will be asked if you wish to overwrite it. 

2 Click Select on the appropriate box on the dialogue box. You will notice 
that the original text on screen does not move but remains exactly as it 
was within your document. 

3 Position the cursor where you wish the text to be placed - for example at 
the end of the passage - then select Paste in the Select menu. You can 
paste as many copies of the selection as you like into the text: the copy 
you saved on the clipboard will stay there until you store a new selection 
there. 

Now try making some style changes to the copy, leaving the original selection 
as it is. 

1 Mark the sentence as a selection in the way described above (Marking a 
selection). 

2 Select a character style or combination of styles using the function keys. 
In the illustration opposite, Light text has been chosen. 

3 Remove the selection highlighting by pressing Menu to call up the top
level menu, and from the Select menu, selecting the Clear option. 

Guided tour 



Deleting your selection 

Saving your document 

Oak woods 

There are two types of oakwood in Britain: daMp oakwoods and 
dry oakwoods. The typical daMp oakwood tree is the 
~dunculfl/ if' with its stalked acot•ns and pecul iat' shaped 
eaves. e ypical tree of the dry oakwoods is the ~ 

ot' Se«si~e Qqll in which the flowet·s, and consequent!~ 
acorns 1 ave no stalks, and the leaves have star-like hairs 
on the1r undersurfaces. 

T .. e, ilt a ,.Jo ,yp " u• oakwood in Bn L:lin: d<:~MP odkwoods and 
dt'Y oakwoods, I 

Mark your restyled selection once again, then select Cut in the Select menu 
to make it disappear and to restore the example document to its original 
condition . 

1st W ord Plus documents are saved in exactly the same way as other 
documents in RISC OS. 

First ensure that a directory display for the directory where you want to keep 
the document is visible somewhere on the screen: a suitable place might be 
the 1 WP _docs directory on the Program disc. Then move the pointer across 
the arrow alongside Save from the top-level menu. A submenu will appear 
allowing you to save either the whole document (or file) or part of it (a 
selection) . Move the pointer across the File option and the Save as dialogue 
box will appear. Use the keyboard to change the name of the document if you 
wish , then drag the icon to the directory display where you want to save the 
document. 
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Skills learnt so far 

How to get help 
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This chapter has taught you several different skills. You have learnt how to 

• start a new document 

• type in text 

• change typestyles 

• make corrections 

• position text 

• make alterations to selections of text 

• save your document. 

These are the basic features of 1st Word Plus. You are now ready to use it to 
produce your own documents. Information on the more advanced features of 
1st Word Plus follows in the next few chapters. 

1st Word Plus will provide instant help information at any time if you select 
Help from the top-level menu to call up the Help menu. The names of the 
various topics about which on-screen help is available will appear as options 
in the menu. Select any one of them to display information relating to that 
topic. 

Once you have read the message, get rid of it by clicking on the OK box. 

If you select Extra help, 1st Word Plus will automatically display a help 
message every time you select a menu option. By using Extra help, you can be 
confident that no menu action will be carried out until you have confirmed it 
by clicking on OK Turn Extra help off by clicking on the option a second 
time. 
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1st Word Plus essentials 

Loading 1st Word Plus 
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This chapter, and the five following chapters, are intended for two groups of 
users of 1st Word Plus: 

• beginners in word processing who have worked through the tutorial in the 
previous chapter 

• experienced users of other word processors who are new to 1st Word 
Plus. 

Some of the information contained in the previous chapter is repeated, but in 
greater detail. 

This chapter tells you how to 

• load 1st Word Plus 

• use the document window and keypad 

• save your documents 

• quit 1st Word Plus. 

If you are running 1st Word Plus from a floppy disc, begin by inserting the 
Program disc into the disc drive. 

Then load 1st Word Plus in the same way as any other RISC OS application: 

1 Open a directory display for the directory containing ls tWord+. 

2 Double-click on the application's icon. 

3 When the icon appears on the icon bar, click Select on it to open a 1st 
Word Plus window. 
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The document window 

20 

There are two ways of loading an ex isting 1st Word Plus document: 

• If 1st Word Plus is already running, drag the document's icon onto the 1st 
Word Plus icon on the icon bar. 

• If 1st Word Plus is not already running, provided you have at some point 
in your sess ion opened a directory display for the directory containing the 
application, double-clicking on the document icon will load 1st Word 
Plus itself, and then the document. 

When you click on the 1st Word Plus icon bar icon, the document window, into 
which you will type your text, appears on the screen. 
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The document window is just like any other RISC OS application window: you 
can move it around the screen and resize it whenever you want. 
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Closing the document 
window 

The keypad 

When you have changed your document, an asterisk appears to the right of the 
filename on the title bar; this warns you that you have changed the document 
since you last saved it. However, you will be warned more explicitly if you 
try to close a document without saving it. 

The 1st Word Plus document window has two features not shared by other 
RISC OS windows: 

• a ruler immediately beneath its Title bar. The ruler settings determine 
the position of the left and right margins and the tab stops. 

• a page border on the left. This shows where new pages will start when your 
document is printed on paper. You can impose conditions on page breaks 
to ensure, for example, that tables are not split across pages. 

Both these features are described in detail in the chapter entitled Document 
layout. 

To close the document window and abandon edits made since the document 
was last saved, click on the C lose icon to the left of the title bar. 

Before the file is closed a dialogue box will be shown warning you that you 
have edited the file since saving it, thus giving you a chance to change your 
mind. 

The keypad window is displayed only when you select Show keypad from the 
menu on the 1st Word Plus icon bar icon. 
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[ili]Insert 0Caps lock I ~ II ~ 11 Delete¢ II Delete ¢ I 
Port: I Parallel Port I Print file . .I Tab II Return I 
Device: I Standard backspacing printer II Space I tl 
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The top two rows on the keypad indicate the effects of the twelve function 
keys at the top of the keyboard. You can obtain the same effect by clicking on 
the boxes on the keypad. 
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Saving your document 
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Also on the keypad are six more boxes which replicate keyboard keys: these 
are Caps Lock, Delete ~. Delete ~ (which has the same effect as the Copy 
key), Tab, Return and Space. There is also a box that allows you to switch 
between Insert and Overwrite modes. 

The lefthand group of boxes, which control effects that are either 'on' or 'off, 
show a star in the box when the effect is switched on. 

T awards the bottom lefthand corner of the keypad are three boxes used for 
installing a printer driver. More information on these is given in the chapter 
Printing your document. 

Fin:ally, there is a box near the centre of the keypad which you use when you 
want to load a supplementary dictionary for checking your spelling. Full 
details of this appear in the chapter Editing documents. 

To remove the keypad from the screen, click on its Close icon; to display it 
again, click Menu on the 1st Word Plus icon on the icon bar and select Show 
keypad. Alternatively, you can drag on the keypad's Title bar and slide it 
partially off the screen rightwards and/or downwards, and then drag it back 
when you need it. 

When you have finished working on a document, you can save it using a new 
name or the name it already had. Use the File option in the Save menu: 

Open a window for the directory in which you want to save the document. 

2 Use the File option in the Save menu to display the Save as dialogue box. 

3 If the document already exists on disc and you want to save it with the 
same name, click on the OK box. You will see a dialogue box warning 
you that you will overwrite the existing document on disc if you continue. 
Click on OK to go ahead. 

4 If your document is new or you wish to rename it, type the new name into 
the dialogue box before dragging the icon to the directory window. 

You can carry on editing the document after saving it. 

If the document does not already exist on disc and you click on the OK box 
without dragging the document icon to a directory window, a dialogue box 
appears, reminding you of what you have to do. Clicking on OK will then 
display the Save as dialogue box. Provided the window for the directory 
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Quitting 1st Word Plus 

Document size 
restrictions 

where you want to save the document is visible, you can then follow the saving 
procedure described above. However, if the window you want is not on screen, 
first click anywhere outside the Save as box to remove it from the screen, then 
open the directory window you want and start the save procedure again. 
Alternatively, type the full pathname in the Save as box, and click on OK. 

When you have finished work on your document and wish to stop working with 
1st Word Plus temporarily, click on the document window's Close icon. If you 
have not saved the document, you will be asked whether you want to save your 
edited file. Click on NO if you wish to go ahead; otherwise click on YES (or 
press Return) to continue working. . 

When you have finished your 1st Word Plus session completely, press Menu 
on the 1st Word Plus icon on the icon bar, and select Quit. If there is no 
unsaved work, and if you have not added any words to your supplementary 
dictionary, the 1st Word Plus icon will simply disappear. However, if there is 
anything you have not saved, you will be asked to confirm that you wish to 
quit. If you now click on OK, 1st Word Plus will be removed from the 
computer's memory and its icon will disappear from the icon bar. To continue 
working, click on CANCEL. 

Although 1st Word Plus occupies quite a lot of the computer's RAM (its 
working memory), there is enough memory left in a 1Mb computer (an 
Archimedes 310 or an unexpanded A3000, for example) for documents of at 
least 150 pages, assuming about 250 words to a page. You will have less 
space than this if you have loaded the dictionary to do some spell-checking, or 
if your document contains pictures. 

Whatever computer you are using, there is an upper limit of about 32,000 
lines for a 1st Word Plus document. In any case, it is good idea to keep your 
files much shorter than this; long files take a long time to load and save, and 
should you delete a file by mistake, you will - of course - lose more work if 
it is very long. If you are writing a book, for example, keep each chapter as a 
separate document. 

1st Word Plus will display a warning when you are running short of memory. 
You can check for yourself the nu'mber of pages, lines, and words in a 
document, as well as the amount of memory remaining, by selecting Statistics 
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The RISC OS command 
line 

Preparing input for 
Acorn Desktop 
Publisher 

in the Edit menu, which displays a box telling you the number of pages, lines 
and words in your document, and its approximate size in bytes, as occupied in 
memory; the disc space it takes up may be less. 

While using 1st Word Plus, you can obtain the RISC OS command line 
prompt at the foot of the screen in the usual way, by pressing F12. 

It is very easy to use 1st Word Plus to prepare text for importing into Acorn 
Desktop Publisher. Changes in type style will survive the import, and 
paragraph styles can be flagged by starting the paragraph with the name of 
the style enclosed in angle brackets. For full details, see the Acorn Desktop 
Publisher user guide. 
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Editing documents 

Very few documents are exactly as you would like them to be when you have 
just typed them in, and most will require some editing such as correction, 
substitution, insertion, or format changes. This chapter covers: 

• moving around your document 

• cursor editing 

• selection editing 

• bookmarks 

• footnotes 

• search and replace editing 

• reformatting text 

• finding your position in a document 

• word processing mode 

• different types of spaces 

• importing text from plain text editors 

• pictures 

• spell-checking 

• using 'unusual' characters . 

Several editing operations can be carried out in alternative ways, using menus, 
the keyboard, or by clicking on the appropriate box in the keypad. These 
alternatives are listed in the chapter Keystroke equivalents, later in this Guide. 
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Moving around your 
document 

Moving the cursor 

When you carry out simple editing on text by deleting or inserting characters, 
the changes always occur at the position of the cursor. You must therefore 
move the cursor to the part you want to alter before making any changes. 
Scroll through your document until the portion you want to edit is visible on 
screen, then position the cursor using the mouse or the cursor keys. 

Y au can use all the usual features of RISC OS windows to move around your 
document. Use: 

• the vertical scroll bars to move forwards and backwards in your text 

• the vertical scroll arrows to move up or down a line at a time 

• the horizontal scroll bars or arrows to move left and right when the 
window is not wide enough to display complete lines of text. 

These features are common to all RISC OS applications, and are therefore 
fully documented in the Welcome Guide or User Guide supplied with your 
computer. 

In addition, Page Up and Page Down on the keyboard scroll one windowful 
up or down, and you can also scroll down (or up) one line by placing the 
cursor on the first (or last) line in the window and pressing J- (or i). 

Once you can see the part of your document which you want to work in, you 
will need to move the cursor to the exact point where you want to edit. You 
can move the cursor e ither with the mouse, by positioning the pointer and 
pressing Select, or by using the keyboard: 

• To move the cursor up or down one line, press J- or i. 

• To move up one windowful, press Shift-i or Page Up. 

• To move down one windowful, press Shift-J- or Page Down. 

• To move the cursor left or right one character, press f-or --7. 

• To move left one word, press Shift-f-. 

• To move right one word, press Shift---7. 

• To move to the beginning of the line, press Ctrl-f-. 

• To move to the end of the line, press Ctrl---7. 
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Deleting text 

Insert and overwrite 
modes 

Insert mode 

• To move to the beginning of the document, press Ctrl-i 

• To move to the end of the document, press Ctrl-.L 

You can use the keyboard in five ways to delete text: 

• To delete a character to the left of the cursor, press ~ or Delete or click 

on Delete f- on the keypad. 

• To delete the character the cursor is on, press Copy or click on Delete ~ 
on the keypad. 

• To delete everything from the cursor to the beginning of the next word, 
press Shift-Copy. 

• To delete the entire line that the cursor is on, press F8. 

• To delete everything from the cursor position to the end of the line that 
the cursor is on, press Ctrl-Copy. 

If you wish to delete several letters, words, or lines, you can use the 
computer's auto-repeat facility by holding down the relevant key(s). Be 
careful when deleting an indent created with F9, because all the stretch 
spaces will be deleted with it. 

You can also use the Select menu to delete larger sections of text (see Editing 
sections of text in this chapter). 

You can insert new text into a document in two ways: in insert mode or overwrite 

mode. 

When you begin a session with 1st Word Plus, insert mode is switched on by 
default. Reflecting this, the Insert mode option in the Edit menu is ticked, and 
the Insert box on the keypad is starred. In this mode, anything you type is 
inserted at the cursor position, pushing everything to the right of it to make 
room. The text of that line is automatically rejustified if you make the 
insertion at the end of a line, but you may need to reformat the rest of the 
paragraph afterwards. 
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Overwrite mode 

Merging documents 

Editing sections of text 

Marking selections 

Overwrite mode is the alternative to insert mode, and is sometimes preferred 
by programmers. As you type in new text, it is written over the existing text at 
the cursor position. Where there is no existing text (for example at the end of 
a line), new text is inserted as usual. In this mode, the Tab and Return keys 
simply move the cursor without inserting any spaces or lines. 

It is easy with 1st Word Plus to merge one document with another by reading 
it in from disc and inserting it into the 'master' document. To do so, follow 
these steps: 

Open a directory display for the directory containing the file you wish to 
merge into your current document. 

2 Place the cursor where you want the new text to be inserted. 

3 Drag the file's icon onto the 1st Word Plus document window. 

The text will then be inserted into your master document at the cursor position. 

The Select menu options will not only let you delete sections of text (called 
selections) and pictures, but also copy them, move them, change their style 
(bold, light, italic, underlined etc), and cut and paste them between 
documents in different windows. Before you can try these options out, you will 
need to mark your selection. 

It is also possible to mark selections of spaces, and then move them, copy 
them, or delete them! Be . careful, though, as only lines containing text are 
highlighted. 

There are two ways of marking selections of text, pictures, or a mixture of 
both. Which you use will depend on the size of the selection: 

• To mark a small selection (when you can see all of it on the screen at 
once), point at the first character to be marked, press Select and drag the 
pointer until the last character you want to include in the selection is 
highlighted. 
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Removing selection 
marking 

Cutting a marked selection 

Copying a marked 
selection 

Pasting the contents of 
the clipboard 

• To mark a large selection, use the Select menu. Position the cursor at the 
beginning of the selection you want to mark, select Start, move the cursor 
to the character after the last one you wish to include in the selection, call 
up the Select menu again, and select End. 

To extend a selection, double-click where you want the selection to start or 
finish. To shorten a selection, place the cursor where you want the new start or 
finish, and select Start or End from the Select menu. To shorten a selection 
from its end, you can, alternatively, double-click at the new end position. 

If you have marked a selection, but cannot remember where it is, select Find 
start or Find end in the Select menu. 

To remove the selection highlighting, either mark a new selection or select 
Clear in the Select menu. Using Reformat in any part of a document also has 
the side effect of removing selection highlighting anywhere in that document. 
You can also remove highlighting by pressing and holding down Select. 

To cut a marked selection, select Cut in the Select menu. The marked 
selection will first be copied onto the clipboard, and a message will appear 
to inform you when this has been done. When you click on OK in this 
dialogue box the marked selection will be cut or removed from your original 
document. If the clipboard already contained an item which you had cut or 
copied from a document and not yet pasted into another place, a warning will 
appear allowing you to cancel your instructions if necessary, as the original 
clipboard contents would be lost if you copied another item over them. 

The clipboard can hold up to about 200 lines of text. 

To copy a marked selection without cutting it from your document, select Copy 
in the Select menu. The marked selection will then be copied onto the 
clipboard, but the original version will be left intact in its current position in 
your document. 

To paste a selection back into your document, move the cursor to the place 
where you wish to make the insertion, then select Paste in the Select menu. 
The selection to be pasted is the one last copied or cut from the text. You can 
paste several copies of the same item from the clipboard back into your 
document, by repeating the paste operation. The copy remains on the 
clipboard until another item is cut or copied onto it. If you have more than one 
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Moving a marked selection 

Restyling a selection 

Using 'bookmarks' 

Setting a mark 

Finding a mark 

30 

window open, you can also cut or copy a selection from one window, and paste 
it into a document in another window, by changing the current window between 
the cut and paste operations. 

To move a marked selection, removing it from its original position and placing 
it somewhere else, position the cursor at the place you want to move it to, then 
select Move in the Select menu. This operation has an effect similar to first 
cutting and then pasting a selection of marked text. This operation also 
involves use of the clipboard, and will delete any exist ing contents from the 
clipboard. 

To restyle a section of text, mark it as a selection, then select a character style 
or combination of styles using the function keys, the key boxes on the keypad, 
or the Style menu. The styles you choose will be applied to the text in the 
marked selection. Key boxes which are currently turned on will be 
highlighted and if you call up the Style menu you will see that any options 
you have chosen have a tick against them. 

If you are editing a fairly large document, you may frequently need to move 
from one part of the text to another. In these circumstances, 1t IS quite easy to 
lose your place. With 1st Word Plus, you can use up to four invisible 
'bookmarks' to keep your place in the text. 

To set a mark anywhere in your document, pos1t1on the cursor at the point to 

be marked, select the Set mark option from the Edit menu and click on the 
number of the mark you wish to set (there is a maximum of four marks). A 
mark with that number will then be set at the cursor position. Marks are not 
visible on the screen, and are not stored with a document when it is saved to 
disc. 

You can now move freely within your document knowing that you will be able 
to move back instantly to your mark at any time. To move the cursor to one of 
your marks, select the Goto mark option from the Edit menu. Select the 
number of the mark you wish to find and the cursor will be moved to that 
mark. 
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Creating footnotes 

The footnote window 

T o create a footnote at the cursor position, select Add footnote in the Layout 
menu. 1st Word Plus will then: 

• Insert a raised footnote number from 1 to 999 in superscript text (like the 

27 here27
). However, you will only be able to place the cursor on the 

first digit of such a number eg '2'. 

• Open up a special footnote window for you to enter your footnote text. 

You can add footnotes wherever you like, except in header lines, footer lines, 
and footnotes themselves! 

The following menu options, when used 'globally' on entire documents will 
include footnotes in their scope of operation, although you may need to close 
the footnote window before you can activate them. 

• Spelling checker 

• Search and replace 

• Statistics 

• Reformat. 

In each case the program deals first with the main text, then deals with each 
footnote in turn. 

If you want to edit a footnote, double-click on its number in the main text. The 
footnote window opens so that you can edit your footnote text using a slightly 
restricted set of 1st Word Plus commands. 
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The footnote ruler line 

Renumbering footnotes 

Deleting footnotes 
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When you have finished ed iting your footnote, click on the footnote window's 
C lose icon. While the footnote window is open you will not be ab le to se lect 
any other window as the current one. 

You cannot paste pictures into footnotes. If you drag a file containing pictures 
into a footnote, they will not be displayed. 

You can alter the footnote ruler whenever you have the window open. By 
default, the left margin of the footnote ruler is indented by three spaces (thus 
starting at column 4) to leave space to print the footnote number. The footnote 
ruler is common to all the footnotes in a document. 

This happens automatically whenever you add or delete a footnote. All 
subsequent footnotes in the document will immediately be renumbered in the 
correct order. This applies even if you merge a file containing footnotes into 
your master document. 

However, you have to reformat the relevant lines of text yourself when the 
number of digits in a footnote number changes (9 to 10 or 99 to 100). You are 
not adv ised to use footnotes in text which cannot be reformatted automatically 
(ie lines which are centred or right-aligned). 

Delete a footnote by positioning the cursor over the footnote number in the 
text window and pressing the Copy key. If the cursor is positioned on the 
character to the right of the footnote number, pressing Delete will delete the 
footnote . Before the footnote is deleted, 1st Word Plus will display a 
warning message to check that you do want to delete the footnote. Click on 
OK to delete the footnote and its number, or on CANCEL to keep the 
footnote . 

To delete a footnote and the word which precedes it in one operation, place 
the cursor at the beginning of the word and press Shift-Copy. The warning 
dialogue box will again appear. 

If you delete some text containing a footnote, you will see the same box 
warning you about the footnote. If you then delete the passage, the footnote 
will be saved on the clipboard along with the text. The remaining footnotes 
will be renumbered. If you go on to paste the section in somewhere else, the 
footnote will appear in the correct position, and the sequence of footnotes in 
the document will be renumbered again. 
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Printing footnotes 

Footnote numbers 

Footnotes are printed at the bottom of the page on which their numbers 

appear. 

The number of a footnote will be printed in the first three columns of the 

first line of the footnote text (although while you are editing the text of a 
footnote, its number appears on the title bar of the footnote window). 

To ensure that these columns will be left empty to take the number, the left 
margin of the footnote window is indented by three spaces: 

This footnote will be printed out as 

1This is a footnote 
with a second line. 

To prevent every line of the footnote text from being indented, you can set the 
left margin at column 1 and create a tab stop at column 4. Press Tab once to 
indent the first line by three spaces: 
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The footnote separator 

This footnote will be printed out as 

2This is a footnote 
with a second line. 

If you do not use any kind of indent, 

the first three characters of your footnote text will be overwritten with a 
footnote reference when you print them out: 

3s is a footnote 
with a second line 

The footnote separator is printed immediately above the first footnote at the 
bottom of each page, and is made up of: 

• up to 9 blank lines, followed by 

• a 'rule' consisting of up to 160 underlined fixed spaces, followed by 
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• up to 9 blank lines. 

To create your own style of footnote separator, within these limits, first select 
Footnote format in the Layout menu to display the following dialogue box: 

Footnote for~~tat 

lines aboue 
Rule length 
lines below 

I Cancel I m 
Click on one of the number fields to move the caret (the red vertical bar) into 
it, then press Ctrl-U to clear the field. Type in the numbers to format the 
footnote separator. By default, there is 1 blank line above the rule (the space 
above the underline characters), the rule is 30 underlined spaces long, and 
there is 1 blank line below the rule. 

The pitch of the rule is taken from the footnote ruler line. To omit the rule 
from the footnote separator, enter 0 for Lines Above on the Footnote Format 
dialogue box. 

If you expect to have more than one footnote printing on a page, add a blank 
line at the end of each footnote to separate it from the next one. For example, 
with the default separator and a blank line at the end of each footnote, the 
footnotes for one page might look like this: 

... the last few lines of a page of 
normal text , shortly followed by ... 

27 This is the first footnote on this 
page and it carries on for a couple of 
extra lines . 

28 This is the second footnote: note 
that the first one had a blank line 
as its last line . 
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Page breaks with 
footnotes 

Search and replace 
editing 

Searching 

1st Word Plus will print a line contammg a footnote number on the same 

page as the footnote text wherever possible. If there isn't enough room on the 
current page, the line and its footnote(s) will be printed on a new page. 

In order for this to work, a one-line conditional page break is displayed in 
the page border when a line contains a footnote number. For information on 
page breaks, see the chapter entitled Document layout. 

This special conditional page break has the following properties: 

• You cannot delete it by clicking on it. 

• You can drag the mouse in the page border to increase the scope of the 
page break downwards (to include following lines), but not upwards (to 
include preceding lines). 

The search and replace facility in 1st Word Plus allows you to search for a 

particular word, phrase, or other string of text throughout all or part of your 
document. The following are all examples of text strings: 'abbot', 'I', 'right
handed', '2nd', 'Mount Everest', 'IS09127'. You can then replace as many 
occurrences of your chosen piece of text with another piece of text as you wish. 

To search for a specific word or phrase in your document, follow these steps: 

Select Find in the Edit menu. The Find string dialogue box will be 
displayed, allowing you to specify: 

• the text string you want to find: press Ctrl-U to clear the line first if 
necessary. You can use '?' as a wild card to stand for any single 
character, including a space. For example, enter 'p?t' to find strings 
such as 'com.Qf!e', 'comJ2!!.!;er', 'J2.i!;', 'Peter', ' uJ2..1o', etc. 

• the direction you want to look in: Down (forwards search, from the 
current cursor position to the end of the document) or Up (backwards 
search, from the current cursor position to the beginning). 
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I 

• whether or not the string searched for must match letter case (capital 
letters or small letters ). If you select Ignore, then 1st Word Plus 
will disregard whether a word is spe lt with capital or small letters. 
For example, if the string is 'bird', it will also search for 'Bird' and 
'BIRD'. 

Find string 

Find !oakwood] 
'?' ~ay be used as a wildcard 

Direction: i>Down <)Up 

Case: i> Match <)Ignore 

I Cancel I OK 

2 Type in the string you want to find, and decide which direction you want 
to search in. Do not press Return at this point, as this would have the same 
effect as clicking on OK 

3 Select whether you want all examples of the character string or only 
those with matching letter case. 

4 Select OK or press Return to start the search . 

1st Word Plus will run through your document in the specified direction 
looking for the first occurrence of the string. 

If the string is found, the cursor will be placed either on the first character of 
the string (backwards search), or on the character immediately after the string 
(forwards search). However, Find will not detect two words in a phrase like 
'1st Word' if they are split over two lines, nor will it find a word that has 
been split automatically with a soft hyphen. 

If the search string is not found, the cursor will be placed at either the 
beginning or the end of your document, depending on the search direction. The 
search direction will then be reversed automat ically the next time you use the 
Find option. 

Editing documents 37 



Replacing 

If you specified Ignore case for a search, and then display the Find string 
box again, you will find that the string you entered before is still there, but is 
now shown in capital letters. If you wish to search for the same string, but this 
time matching lower-case (or a mix of case), you will need to re-type the 
string. 

T o replace a specific word or phrase m your document with another, follow 
these steps: 

Select Replace in the Edit menu. The following Find and Replace 
dialogue box will be displayed: 

Find and rePlace 

Replace !oakwood 
~===;======~ with I pi newoodJ 

•?• ~ay be used as a wildcard 

Direction: <$> Down (>Up 

Case: <$> Match (>Ignore 

Rep lace: <$>One (> So~e (>A 11 

I Cancel I I OK 

This is similar to the dialogue box displayed for Find, and allows you to 
specify: 

• The string of text you want to find. Press Ctrl-U to clear the line first 
if necessary, since if you have already specified a string using Find 
the dialogue box will still display that string. As with Find, you can 
use '?' as a wildcard to stand for any character, including a space. 

• Your replacement text. Do not press Return yet! 

• The direction you want to look in: Down (onwards search, from the 
current cursor position to the end of the document) or Up (backwards 
search, from the current cursor position to the beginning). 

• Whether the string searched for must match letter case or not. For 
details, see Searching in this chapter. 
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• Whether to replace One, Some, or All occurrences (the scope of 

replacement). 

2 Type in the text you wish to search for, and the text you wish to replace it 
with, choose the scope of this replacement and so on. 

3 Finally, click on OK, or press Return. 

If you specify replacement of One or All matches, Replace will search and 
replace automatically. If you specify replacement of only Some matches, 
Replace will find and display each match and ask you whether to Replace 
the text, Continue without replacing, or Stop the search altogether. 

Re]l_lace 

!Replace!lcontinuel~ 

You can use the Replace option to make multiple replacements, insertions or 
deletions: 

• To replace occurrences of 'cement' with 'glue', give 'cement' as the text to 
be found and 'glue' as the replacement text. 

• To insert 'and glue' after the word 'cement', give 'cement' as the text to be 
found and 'cement and glue' as the replacement text. 

• To delete 'cement', give 'cement' as the text to be found, press Return to 
move the cursor to the replacement text (with) box, then press Ctrl-U to 
leave this line empty, before clicking on OK. 

As with Find, if the search string is not found, the cursor will be placed at 
either the start or end of your document, depending on the search direction. 
The search direction will then automatically be reversed the next time you use 
the Replace option. 

To repeat the last Find or Replace, use the Repeat find option in the Edit 
menu This uses the same choices but without redisplaying either of the 
original dialogue boxes. If the Find or Replace finished at the start or end of 
the document, then Repeat find will automatically reverse the search 
direction. 
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Reformatting text 

Finding your position in 
the document 

After deleting or inserting any text, or using search and replace, you will 

probably need to reformat your text. There are three ways of doing this, 
depending on how much text is to be formatted. 

To reformat a single paragraph, position the cursor anywhere in the first line 
of the paragraph, then press F7 . Although 1st Word Plus remembers indents 
when you reformat single paragraphs, you will need to reformat hanging 
indents, centred paragraphs, and right-aligned paragraphs line by line. 

If you choose to reformat a paragraph the cursor will be placed at the end of -., 
the paragraph after reformatting. 

To reformat the text from the ruler before the cursor position to the ruler 
after it, select Between rulers from the Reformat option in the Style menu. 

To reformat the whole document, select Whole document from the same 
menu. Footnotes will also be reformatted when you select this option. 

1st Word Plus distinguishes between the end of a line and the end of a 
paragraph in the following way: 

• a line has a space at the end of it 

• a paragraph has a Return at the end of it. 

If there is a space before the Return at the end of a paragraph, it will be 
reformatted onto the following paragraph. 

Select Show posttlon in the Layout menu to display the current posltlon of 
the cursor in your document, eg Page 17 Line 4 Column 58. This information is 
displayed on the ruler line in place of the current ruler. Click on Show 
position again to turn the position display off or select Show ruler to 
redisplay the current ruler. If the current cursor position is displayed, Show 
position will have a tick by it. 

When WP mode (see below) is not switched on, only the line and column 
position will be given, as non-word processed documents are not divided into 
pages. If neither Show position nor Show ruler is switched on you will have 
one extra line of text visible in your workspace. 
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Finding a page 

Word processing mode 

Different types of 
spaces 

To move to a given page in your document, select Goto page in the Edit menu. 
In the Goto Page dialogue box, type in the page number you want and click 
on OK 1st Word Plus will move to the page you have specified and display 
it in the text window with the cursor on the first character. 

With documents more than 99 pages long, you can move to any page number 
(eg page 212), although the page border will only display the last two digits 
(eg 12). If you specify a number greater than the size of the document, 1st 
Word Plus will position the cursor at the top of the last page. 

If word processing mode (see below) is switched off, the Goto page option 
changes to Goto line. 

Files can be created and edited with WP (word processing) mode switched 
either on (for document files) or off (for program, data, and other non
document files). WP mode is controlled from the Edit menu. 

When a document is saved with WP mode on, the page breaks and style 
changes in your document are saved with it. 

When you want to work on a non-document file such as a computer program, 
switch WP mode off. Printer driver source files, as described in the 
Appendix, should also be prepared and saved in non-WP mode. Only the 
text itself ('plain ASCII' in computer terminology) will be saved. 

With WP mode off, you will not be able to use 

• indents 

• any kind of page break 

• any of the Style menu commands 

• hyphenation or word wrap 

• text reformatting 

• the text pitch, right justification, or line spacing options on the ruler line. 

You may notice when moving the cursor that it will occasionally 'jump' over a 
space onto the next character. This is because 1st Word Plus uses four 
different types of space, and you can only position the cursor on three of them. 
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Variable and stretch 
spaces 

Fixed spaces 

When you press the Space bar, a variable space is inserted into the text at the 
cursor position. 1st Word Plus may widen a variable space by adding one or 
more stretch spaces to it when it right-justifies a line (see Justification in the 
chapter Document layout). You will be able to place the cursor on the variable 
space but not on the stretch spaces which 1st Word Plus may have added to it. 

1st Word Plus treats the variable space and any stretch spaces which may 
have been added to it as a single unit. When a variable space is deleted, any 
stretch spaces associated with it are deleted as well. 

To insert a fixed space, press FlO. You can always place the cursor on a fixed 
space. 

A fixed space will never have stretch spaces added to it, nor is it ever used as 
a potential word wrap point during right justification. Use it to link words or 
numbers which you do not want the program to move further apart or split 
over different lines, such as: 

• Names AT Smith 

• Telephone numbers 071-300 0200 

• Addresses 13 Grove Street 

• Postcodes CB4 S]A 

Pressing Tab inserts fixed spaces into the text up to the next tab stop (see the 
section Tabs in the chapter Document layout). 

All spaces in files created with WP mode switched off are fixed spaces, and 
paragraphs containing them can only be reformatted as follows: 

Switch WP mode on again. 

2 Select Replace from the Edit menu. 

3 Replace all spaces by spaces by pressing the space bar once in the 
Replace box and once in the with box. (This is not as pointless as it 
sounds: the effect is to replace fixed spaces by variable spaces.) 

4 Place the cursor at the beginning of the paragraph and press F7 to 
reformat the text. 

5 Click on OK to effect the change. 
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Indent spaces 

Importing text from 
plain text editors 

An indent is inserted into the text when you press F9. This gives a similar 
effect on the screen to using Tab, but actually consists of a single indent space 
followed by stretch spaces to the next tab stop. The cursor can only be 
positioned on the indent space and deleting this will delete the associated 
stretch spaces as well. For further details, see the section Indents in the 
chapter Document layout . . 

Now you are a 1st Word Plus user you may wish to import a document you 
have prepared in a plain text editor (such as Edit, supplied with your 
computer) into 1st Word Plus. If you just want to print your document from 
1st Word Plus, and you don't want to make any changes that will involve 
reformatting, you can simply load it into 1st Word Plus by dragging it onto 
the icon bar icon. 

However, the two applications handle certain things like spaces and carriage 
returns differently, so if you want · to work on the text and reformat it, you 
need to make a few <;hanges to the document in Edit before loading it into 1st 
Word Plus. Although a little fiddly, these changes are quite straightforward. 
Follow these steps: 

Load the document into Edit. 

2 With the cursor at the beginning of the document, press F4 to call up the 
Find text dialogue box. Click on the box next to Magic characters. 

3 Replace the sequence \n \n with a sequence of characters that does not 
occur elsewhere in your document. Try something like xzxz, or zyzy, but 
check first if you're not sure. (This will enable· you to restore your 
paragraph structure later.) Press Return, and in the Text found dialogue 

--. box, click on End of file Replace. 

4 Click on Stop to remove the Text found box. Place the cursor at the top 
again by pressing the Home key. 

5 Replace 'space' (just press the Space bar once) with \xlE. This changes 
hard spaces to variable spaces. 

6 Click on Stop to remove the Text found box. Place the cursor at the top 
aga in. 

7 Replace \n with \xlE\n. This replaces single carriage returns with a 

variable space followed by a carriage return, and will take some time. 
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Pasting in pictures 

44 

8 Click on Stop to remove the Text found box. Place the cursor at the top 
again. 

9 Replace the character string you used in step 3 by \ n \ n (restoring your 
double carriage returns). 

10 Call up the Save as dialogue box in Edit and drag the icon onto the 1st 
Word Plus icon bar icon. 

As 1st Word Plus cannot handle documents containing more than about 32,000 
lines, you will not be able to load larger Edit files than this. In addition, you 
cannot load Edit files containing control characters. 

1st Word Plus allows you to paste pictures created by programs such as Paint 
(supplied as part of the Applications Suite with your computer) into your 
document. (Pictures created by drawing applications such as Draw cannot be 
loaded into 1st Word Plus.) 

To load a picture, place the 1st Word Plus cursor where you want the picture 
to appear. Then open a directory display for the directory containing the 
picture file, and drag the picture icon onto the 1st Word Plus document 
window. The picture will be displayed below and to the right of the cursor 
position, but before any text on the same line. 

1st Word Plus must be in graphics mode in order to display pictures on 
screen, and graphics mode will be switched on automatically when you first 
load a picture into a document. However, if there is not enough memory to 
load a picture, graphics mode is automatically switched off and any pictures 
you have loaded already are removed from memory (you still get the picture 
outlines on screen). 

You can switch graphics mode off yourself, in order to save memory, reduce 
the time taken to re-draw the screen when scrolling, or to avoid confusion 
when editing text which is overlaid by graphics. To switch off graphics mode, 
click on the Graphics mode option in the Graphics menu. The tick alongside 
the option will disappear, and pictures will not be displayed, though their 
outlines will still be visible. 

Switch graphics mode back on by clicking on Graphics mode again. If you do 
this, remember that: 
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Moving pictures 

Deleting pictures 

• no pictures will be loaded if there is not enough memory to load them 
all; graphics mode will be left switched off. 

• you will get an error message if you have removed the floppy disc 
containing the pictures from the disc drive. Any picture that cannot be re
read is deleted from the document. 

When you paste a picture into a document, information about it is stored in 
the document file. This information includes where in the document the 
picture is pasted, and where on the relevant disc (relative to the document 
itself) to find the picture. If you move any of your pictures after you have 
pasted them into your document (for example, into a different directory), 1st 
Word Plus will look in the original directory for the pictures when you 
reload that document, and will display an alert for each picture it cannot find. 

If you move the document to a different directory, you should therefore move 
the picture too, so that it remains in the same place relative to the document 
file . 

If you have a printer driver installed, the picture will have a dotted line 
around it to indicate the amount of space it will take up when printed out on 
that particular printer. If no printer driver is installed, a default picture size 
will be indicated which is valid for many common printers. 

Once the picture is pasted into your text, you can move it, write over it, 
increase the space around it, or (if you are not happy with it) delete it. 

To move your picture, place the pointer over it, then hold down Select. The 
pointer will change shape to a flat hand. Drag the picture to where you want it. 

You can overlay pictures onto other pictures, put text and pictures side-by
side, write over your pictures, or move selections of text on top of them. 

To increase or decrease the amount of space between your picture and the rest 
of the text, position the cursor at its top or bottom edge. Use Return to insert 
extra lines of space, and FS to remove lines. 

To delete your picture, click Select somewhere on it. The cursor will move to 
the beginning of one of the lines occupied by the picture. Select Delete 
picture from the Graphics menu. I The picture will be highlighted, and a 
message will appear on the screen asking whether the correct picture has been 
selected. Select OK to delete the picture. 
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Using the spelling 
checker 

If you have more than one picture on the same line, 1st Word Plus may be 
unable to tell which picture you wish to delete. To overcome this, if necessary, 
move the picture to another part of the page before deleting it. 

Deleting a picture will leave an empty space in your text, which you can 
remove by marking it as a selection (remember you will not see the 
highlighting when no words are being marked), then sdecting Cut in the 
Select menu. 

Once a picture is pasted into posltlon, it effectively becomes part of the text 
of the document. This means that all the Select menu operations can be 
carried out on pictures, or a mixture of pictures and text. In some cases it may 
be faster to delete a selection of picture(s) and text using Cut, rather than 
removing each picture using Delete picture and then deleting the text. 

1st Word Plus comes with a 70,000 word spelling dictionary which helps you 

check that every word in your document is correctly spelt either: 

• all in one go, after you have finished typing it in, or 

• continuously, as you type each word in. 

The spelling dictionary you get with 1st Word Plus obviously cannot contain 
all the words you will need to check, but it does have the most frequently 
used ones. In particular, it contains only a limited selection of proper names 
(words like Iceland and Uranus) and legal, scientific and other technical 
terms. 

However, with 1st Word Plus you can add these words as required to your 
own personal or supplementary dictionary. Since you can create as many of 
these personal dictionaries as you need, you will be able to build up your 
own 'library' of dictionaries. 

When 1st Word Plus comes across a word which it does not recognise and 
which is misspelt, it will suggest a list of correct spellings for you to choose 
from. Select the word you want, and 1st Word Plus will then replace the 
misspelt word in your document with the right one. 

However, one thing that the 1st Word Plus spelling checker can't do is to spot 
a correctly-spelt word which is incorrect in its present context, eg 'Theirs won 
borne every day'. 
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Loading the spelling 
dictionary 

Continuous spelling check 

In addition, note that the spelling checker treats number characters the same 
as spaces between words. Therefore, if you typed 'now6is6the7time ... ', 1st 
Word Plus will not recognise the errors. 

To load the main spelling dictionary from disc into your computer, select 
Load dictionary in the Spelling menu. 1st Word Plus will search for the main 
dictionary in the directory in which the 1st Word Plus program is to be found. 

To load a supplementary dictionary, drag the dictionary icon from its 
directory display onto the keypad. The supplementary dictionary you load 
will then be used for checking the spelling of any 1st Word Plus documents 
you are working on; they form part of your 1st Word Plus 'world'. 

Supplementary dictionaries are files of type lWpDi ct created by 1st Word 
Plus. (For information on file types, see your User Guide.) They can be given 
any name you like, but it is a good idea to use a filename which helps you to 
recognise the file as a supplementary dictionary, eg COOKERY SUP ( = 

"SUPplementary dictionary") . They must not, of course, be given the same 
name as any other file, especially the file they are to be used with, as you 
would then delete either the document or the dictionary when saving. 

You may wish the same supplementary dictionary to be loaded each time you 
start spelling checking. To achieve this, save your supplementary dictionary 
with the filename lwp_sup in the application directory itself (! lstWord+). 

To open a directory display for the application directory, hold Shift while 
double-clicking on its icon. 

You can load more than one supplementary dictionary at a time; their contents 
will be merged for the current session. 

To check the spelling of each word as you type it in, select Continuous 
spelling in the Spelling menu. As soon as you move the cursor off the word 
you have just typed in (by pressing the Space bar, for example), the word is 
checked against both the main dictionary and the supplementary dictionary. If 
it is not found, the computer will 'beep' to show that 1st Word Plus does not 
recognise the word. You can then do any one of the following: 

• carry on typing, leaving the word as it is 

• correct the misspelt word manually 

• use the diction~ry browser to correct it (see Using the browser) 
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Checking whole 
documents 

Adding words 

• if the word is correctly spelt, add it to the supplementary dictionary (see 
Adding words). 

To check the spelling in an entire document in one go, place the cursor 
wherever you wish to begin the spelling check, then either click on Check 
spelling in the Spelling menu or press Escape. The spelling checker will look 
at each word from the current cursor position to the end of your document, and 
stop at any word it does not recognise, placing the cursor after it. You can then 
take any one of the following steps: 

• correct the misspelt word manually 

• use the dictionary browser to correct it (see Using the browser) 

• if the word is correctly spelt, add it to the supplementary dictionary (see 
Adding words). 

To continue checking the spelling in your document, either press Escape again 
or select Check spelling in the Spelling menu. 

To add a new, correctly spelt word directly to the supplementary dictionary, 

select Add word in the Spelling menu. The last word that the program 
detected as unrecognisable will then be added to the dictionary, unless you 
have altered the contents of the Find box in the browser since that detection 
was made. In this case, the new contents of the Find box will be the item 
added. When the addition has been made, either continue the spelling check 
as described above or carry on typing in text. 

You can also add words either with the browser (see Using the browser), or by J 
merging a supplementary dictionary into the main dictionary (see Merging 
dictionaries). 
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Using the browser - To check that the word has been added, select Browse in the Spelling menu to 
display the dictionary browser. 

Browse 

I Find llacornj I 

acorn 

I Guess I acorns 
acoustic 
acoustical 

I tr I acoustically 

I ~ I acoustics 
acquaint 
acquaintance 

I Exit I acquaintances 
acquainted 

I Add ito suppleMentary dictionary 

The browser window displays a merged list of words from both the main 
spelling dictionary and your supplementary dictionary (if you have loaded 
one). Whenever you call up the browser it will display the last word added 
or spelling mistake found, and 1st Word Plus will also display the 
corresponding page in your document in the document window. 

To find a particular word, press Ctrl-U to clear the Find line, type in the 
word, and click on the Find box. The program will find your word (if it is in 
the dictionary), and highlight it at the top of the browser window. If the word 
is not in the dictionary, the browser window will display the part of the 
dictionary which is closest in spelling to it. 

To search through all the words beginning with a particular letter of the 
alphabet, click on the up or down arrow to the left of the word box to scroll 
the contents of the browser window. 
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Spelling correction 
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To add a new word to the supplementary dictionary at any time, press Ctrl-U 
to clear the Find line, type in the new word, and select Add. 1st Word Plus 
will add your new word to the supplementary dictionary and highlight it in 
the word box. 

The browser also allows you to correct automatically any misspelt words in 

the document you are checking. Let's say you have typed in 'steck'. When you 
check your spelling, 1st Word Plus will place the cursor after this word to 
show you that it is not in either of the dictionaries. 

Move to the Spelling menu and select Browse to display the browser. This 
will list words that come after 'steck'. Now ~e lect Guess, and the spelling 
checker will show you a list of suggested correct spellings. 

Bro~e 

Find llsteckl 

speck 
Guess stack 

stick 
stock 

1} stuck 
!} steak 

Exit 

Add Ito supple~entary dictionary 

IReplacelin docu~ent 

Select the correct spelling in the browser word box ('steak', 'speck', etc), then 
select Replace to insert it into your document. If the correct spelling does not 
appear in the list of suggestions, you can select Find to . return to a full 
browser listing, then search through the dictionary as before. 
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Saving the dictionary 

Editing dictionaries 

,........, Merging dictionaries 

I 
I 

A session of spell checking ends either when you select End spell check in 

the Spelling menu, or Quit from the 1st Word Plus icon bar menu. 

If you have added any words to the dictionary, 1st Word Plus will display a 
dialogue box to allow you to save the supplementary dictionary to disc either 
with the same name as the original supplementary dictionary you had loaded, 
or with a new name. By default, the dialogue box will display the name of 
the original supplementary dictionary but you can change this name if you 
wish. If you have loaded more than one supplementary dictionary, the default 
filename will be that of the last one you loaded. 

If you had not loaded a supplementary dictionary, the words you have added 
will form the basis of a new one, which you can save in exactly the same way. 

If you want to stop using one supplementary dictionary and load another, 
select End spell check from the Spelling menu. When the warning appears, 
save the supplementary dictionary. Restart spelling checking by selecting 
Load dictionary again, then load the supplementary dictionary you want. 

To delete words from a supplementary dictionary, simply load it into 1st 
Word Plus as you would any_ other document file and edit it. To delete words 
from the main dictionary, you will need to create a special supplementary 
dictionary and merge the two dictionaries together, as described in the 
following section. 

The dictionary merging program, lstDMerge, which is supplied with 1st 
Word Plus on the Utilities disc, allows you to: 

• merge a supplementary dictionary into the main dictionary 

• add new words to the main dictionary 

• delete unwanted words from the main dictionary. 

When you add words to a dictionary during a 1st Word Plus spelling session, 
they will in fact be added. to the supplementary dictionary. If you know you 
will always want these words in your dictionary, you can add them to the main 
dictionary itself. 

A lternatively, you can use 1st Word Plus to create a file contammg just the 
words you wish to add to or delete from the main dictionary. Create this file 
in the same way as you would any other text file, but ensure that WP mode is 
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switched off. (Do this by clicking on WP mode in the Edit menu: the tick 
indicating that WP mode was operating will disappear.) Press Return after 
typing in each word to ensure that it appears on a separate line. Place a minus 
sign (hyphen) at the beginning of each of the words to be deleted 
eg -delete, -wo rd, - list, etc. Save the document in the normal way. 

When you run lstDMerge, the words preceded by a minus sign will be 
removed from the main spelling dictionary. Words not preceded by a minus 
sign will be added to the main dictionary if they are not in it already. 

When you double-click on its icon in the directory display, lstDMerge will 
run immediately (rather than appearing on the icon bar), and the following 
dialogue box will be displayed: 

Main dictionar!l 
~ Dr~g a file of 
E!:J th1s type to 
this window or enter 
a filenane below. 

I Cancel II OK 

To merge the dictionaries, follow these steps: 

Drag the icon for the main dictionary (the dictionary into which you want 
to merge a smaller one) onto the dialogue box, and click on OK. 

2 A second, similar, dialogue box will appear, asking you for the name of 
the supplementary dictionary that you wish to merge into the main one. 
Again, drag its icon onto the dialogue box and click on OK. 

3 A Save as dialogue box will appear. Use this in the normal way to 
indicate the name you wish to give the merged dictionary, and drag the 
icon to a directory display. 

4 The merge will then begin, displaying a box to show its progress. 

5 When the merge has finished, a message will appear to inform you of the 
fact. C lick on OK to complete the process. 
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Using a merged dictionary - . 

Unusual characters 

-

1st Word Plus loads the main dictionary lwp spell when you select Load 
dictionary from the Spelling menu. If you want your new merged dictionary to 
take the place of the old main d ictionary, rename it lwp_spell , and save it 

into the Application directory ! lstWord+. 

1st Word Plus comes with· a utility program called lstChars, which enables 

you to enter characters with accents and other characters which do not appear 
on the keyboard, into your text. 

You will find it on the Program disc. When you double-click on its icon to run 
it, you will see the following window: 

~1[31 Character Set 
ABC DE F G HI J K L M N 0 P Q R STU U W X Y Z0! ? II ' ~ . } ' 
a b c d e f g h i j k 1 ~ n o p q r s t u v w x y z , i i. I ' ' } 

~ ~ ~ ~ ~ R H ~ t ~ ~ ~ i i i ~ D ~ 0 6 6 a ~ H ~ 6 Q U 0 ~ B v 
~ ~ a ~ a a l P ~ ~ @ e 1 i 1 1 a n o o o o o ~ u u u u ~ ~ y u 
1 2 3 4 5 6 7 8 9 8 + - X + = • I \ ± N , - ( ) [ ] { } ( ) « » ~ 
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Click on the character you want, and it will appear at the cursor position in 
your 1st Word Plus document. A lternatively, press Shift with the pointer 
highlighting the character (this method allows you to use non-keyboard 
characters in filenames). 

When you have finished with 1stChars, click 1n its C lose icon. 
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Setting up the margins 

Paper size 

This chapter is a reference guide to formatting your document with 1st Word 
Plus. It explains how to use the many layout facilities offered by 1st Word 
Plus, including such things as: . 

• how to set the left and right margins, and then line up your text in 
between them 

• how to make use of the variety of type style options available with 1st 
Word Plus 

• how to use rulers to vary line spacing,_ tabs and text pitch at different 
points in your documents 

• how to organize page layout (paper size, header and footer text, chapter 
and page numbers) to suit your printer. 

Several of the layout operations described in this chapter can be carried out 
in alternative ways, using either menus or keystrokes, or by clicking on the 
appropriate box in the keypad window. These alternatives are · listed in the 
chapter Keystroke equivalents, later in this Guide. 

To set the margins at the top and bottom of your document when it is printed, 
select Page Layout in the Layout menu to display the Page Layout dialogue 
box. Use the down arrows to reduce the value displayed, and the up arrows to 
increase the value. 

Paper Length shows the total number of lines your printer paper is 
physically capable of holding. Alter the Paper Length value only when you 
change the size of the paper in your printer. The default value (the standard, 
unless you change it) for this option is 66 lines. 
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Foot margin 
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If you have a cut-sheet feeder, your printer may restrict both the page length 
and the position of the first printed line. In this case, you may need to 
experiment a little to get the correct page layout. For example, an Epson LQ-
800 printer with an A4 sheet feeder attached needs a paper length of 70 
lines, a TOF margin of 1 line, and a BOF margin of 9 lines. 

Page layout 

Header 
Left II I 
Centre I I 
Right I I 

Footer 
Left I I 
Centre I# I 
Right I I 

Paper length ~[QJ[QJ Linestpage ~ 
TOF 111argin ITJ[QJ[QJ BOF 111argin rnrnrn 
Head 111argin rnrnrn Foot 111argin rnrnrn 

!Cancel I OK 

This shows the number of lines between the top of each sheet of paper or 
form and the header line, excluding the header. The default value for this 
option is one line. 

This shows the number of lines between the header line and the first line of 
text, including the header. The defau lt value for this option is three lines. If 
you set this option to zero lines, the header line will not be printed out. 

This shows the number of lines between the last line of text and the footer 
line, including the footer. The default value for this option is three lines. If 
you set this option to zero lines, the footer line will not be printed out. 
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This shows the number of lines from the footer line to the bottom of the sheet 
of paper, excluding the footer. The default value for this option is one line. 

The total number of lines which will be printed on each page is then worked 
out by subtracting the margins from the paper length . The default value is 54 
lines per page. 

The left and right margins are set with the ruler. Details of how to do this are 
given later in this chapter. The right margin determines where the line ends, 
and hence where word wrap and right justification will occur. 

1st Word Plus allows you to specify header and footer lines of text to be 
printed on each page. The diagram below shows where the header and footer 
lines will appear on each page in relat ion, first, to the paper length and 
second, to the total number of lines of text on each page (or the page length). 

Header 
line 

Footer 
line 
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Head UHead C/Head R 

Foot UFoot C/Foot R 

Page numbering 

Head margin and foot 
margin 

Rulers 

Headers and footers take their ruler settings from the first line of a 
document. For example, if the first line is in expanded pitch (six characters 
per inch), the headers and footers for that document will also be in expanded 
pitch. If you do not wish the headers and footers to have that setting, you can 
insert a blank line at the beginning of the document above the headline and 
give it a different ruler of your choice. 

Headers and footers, like margins, are controlled from the Page layout 
dialogue box, reached from the Layout menu. 

These boxes allow you to specify what is printed in the header line on each 
page. Text in the header line may be centred, or aligned left or right. Enter 
the text you want for each part of the header. Use the mouse to move the 
cursor to each box in the normal way. 

These boxes allow you to specify what is printed on the footer line on each 
page. Text in the footer line may be centred, or aligned left or right. Again, 
enter the text you want to appear in each part of the footer. 

If there is no entry in a header or footer box on the dialogue box, then nothing ""l· 
will be printed in the corresponding place on the pages of your document. 

Type the number symbol '#' in a header or footer box to print the page 
number. The page number is printed at Foot Centre by default and will need 
to be deleted from that box on the dialogue box if you do not want it printed 
there. 

Make sure that the Head margin and Foot margins are both set to at least 1, 
or the headers and footers will not appear (see the earlier section Setting up 
the margins). 

The width of the text you are typing, the left and right margins, and the 
positions of the tabs (as well as the character and line spacing described in 
later sections of this chapter), are determined by the ruler, which appears at 
the top of the text window. 

The ruler line shows which ruler you are using at the current cursor posltlon. 
By default, this ruler is set up for 65 characters per line, with tab stops every 
5 characters: 
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Adding a ruler 

. To tum the ruler line display on and off, select Show ruler in the Layout 
menu. If the ruler is currently displayed, Show ruler will have a tick by it. If 
you select Show position in the same menu, the ruler display will be turned 
off and the line number and column number of the current cursor position 
will be shown instead. 

You can add as many new rulers at various places in your document as you 
wish. This lets you use, say, a different paragraph width for quoted text, or a 
different set of tab stops for tables. However, you may wish to modify an 
existing rulen rather than adding a new one; for how to do this, see the end of 
this section. 

To add a ruler at the cursor posttton, select Add ruler in the Layout menu. 
The Add Ruler dialogue box will be displayed, allowing you to select your 
own combination of tab spacing and ruler length (as well as line spacing and 
character pitch). 

The new ruler will appear in the normal position at the top of the window; 
the ruler displayed there will always be the one that applies to the line the 
cursor is currently on. 
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Add ruler 

Pitch: Tab spacing: 
<!>Pica 0306 
0Elite 0408 
Ocondensed <!> 5 019 
0Expanded Tab type: 

0Justify 
<!>Spaces 
0Dots 

Ruler length @]@]@] 
Line Spacing []@]@] 

I Cancel I OK 

Use the up or down arrows (or type in a value directly) to increase or 
decrease the ruler length to any number between 10 and 150 characters. (This 
figure refers to the position of the right margin, not the distance between the 
left and right margins.) The default ruler lengths for the four character 
pitches (spacings) are based on a line 6.5 inches long: 

• 65 characters (Pica pitch) 

• 78 characters (Elite pitch) 

• 112 characters (Condensed pitch) 

• 39 characters (Expanded pitch). 

Character pitches are explained in the section below entitled Character 
spacing. 

When you have selected the ruler length you require, click on OK to insert 
the new ruler at the current cursor position. The new ruler, with the 
characteristics you have given it, will appear in the normal ruler position at 
the top of the document window. An inserted ruler will affect all text up to 

the next ruler in the document. 
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Deleting a ruler 

Modifying a ruler 

Modifying a ruler with the 
mouse 

Remember to reformat your text when you have added a new ruler by using 
function key F7, or selecting Reformat in the Style menu. For more details, 
see the section Reformatting text in the previous chapter, Editing documents. 

The block of lines extending from the line where you added a new ruler to 
the line before that on which the next new ruler is added is referred to as the 
scope of a ruler. 

To check how far down the page a particular ruler's scope extends, press and 
hold Select with the pointer on the ruler icon at the lefthand end of the ruler 
under the Back icon. A line indicating the scope of the ruler will be 
displayed in the page border on the left of the text window. 

To remove a ruler from a document, place the cursor anywhere in the ruler's 
scope, then select Delete ruler in the Layout menu. Don't forget to reformat 
your text after you delete a ruler. 

To modify a ruler, first place the cursor anywhere within its scope. 

Double-click on the ruler icon at the lefthand end of the ruler to display the 
Modify ruler dialogue box. Except for its title, this is the same as the Add 
ruler dialogue box. Select the combination of character pitch, tab spacing, tab 
sty le (ie space or dot), etc which you require, then select OK to update the 
ruler line. 

After modifying a ruler, you will need to reformat the text within the scope 
of that ruler. To do this, move to the Style menu, and select Between rulers 
from the Reformat menu. 

You can also modify some features of a ruler (the tab stops and the margins) 
using the mouse. Position the cursor within the scope of the ruler you want to 
change, then drag the left and right margin stops to the new position you want. 

To drag the right margin outside the current window area, you must first 
horizontally scroll the window. 

Use F7 to reformat each paragraph to the new text width. 

Document layout 61 



62 

Storing rulers and 
document layout 

Tabs 

Left-aligned tabs 

1st Word Plus stores the rulers and document layout along with the text when 
you save a document in WP mode. The stored rulers will be redisplayed 
when you next open the document for editing. 

If there is a document pattern that you use regularly, save an empty document 
(ie one containing no text) with that layout or ruler (or both) to serve as a 
template. You can then load the empty file and type your text into · it. 
Remember to give the document a new name when you first save it, or you 
will overwrite the empty template file. You can extend this idea to include 
frequently-used text components such as letterheads. 

1st Word Plus has two different types of tabs: left-aligned and decimal. 
Decimal tabs can also be used to right-align text. As on a typewriter, you can 
preset tab stops for aligning columns of text, formatting tables, and so on. 
When you press Tab, the cursor will move to the next tab stop to the right. 

Tab positions are set from the Add Ruler dialogue box, reached from the 
Layout menu, or from the Modify ruler dialogue box, reached as described 
on the previous page. Use the mouse to select the required gap between tab 
stops (3 4 56 8 10 etc). 

You can also choose between dots and spaces as leader characters: the 
character used to fill in the space between tab stops and text. 

You can also set and clear tab stops by clicking on their position on the ruler. 
Use this method if you wish to change the regular positioning of tabs set up m 
the Add ruler dialogue box to some irregular pattern. 

This is the normal type of tab, where the lefthand edge of the word lines up 
with the tab. This table uses left-aligned tabs: 

kelvin 
second 
mole 

kilogram 
ampere 
candela 

Left-aligned tabs are marked on the ruler with diamond shapes. Twelve left
aligned tabs are set at five-character intervals in the default, 65-character 
ruler. 
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Using decimal tabs for 
right-aligning 

Character spacing 

You can use 1st Word Plus Decimal tabs feature to line up columns of 
decimal numbers on their decimal point in the following way: 

156.4 
8445.0 

28.9854 

2.4666 
7800.25 

.58348 

Double-click on any point on the ruler line to insert a decimal tab. The 
position of the decimal tab will be indicated by a# sign. 

Anything you now type in will be moved leftwards from the decimal tab until 
you do one of the following: 

• type a decimal point or a space 

• press Tab or Return 

• reach any previous text on that line. 

To remove a decimal tab from the ruler line, click on it again. 

You may want to align whole numbers or any string of characters in a table 
on their righthand edges. Strings containing no decimal point are effectively 
right-aligned by a decimal tab: 

Andrew 
Bill 

Charles 

Anne 
Betty 
Carol 

Character spacing, or pitch, is set

1
at the same time as the ruler, and hence 

applies to text within the influence o a particular ruler. 

To alter character spacing, select dd ruler from the Layout menu. The Add 
Ruler dialogue box will be dis layed. Alternatively, double-click on the 
ruler icon to modify the current uler (the ruler applying to the line where 
the cursor is). 

Select the character spacing ('pitch') you require by clicking on one of: 

• Pica (10 characters per inch) 

• Elite (12 characters per inch) 

• Condensed ( 17 characters per inch) 
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• Expanded ( 6 characters per inch) . 

When you select one of these, the ruler length will change to the default 
length for that pitch. If you want a different number of characters to a line, 
change the value in the Ruler length box after selecting the pitch. 

The appearance of characters on the screen will not change when you select 
different pitches, but they will be printed on paper with the pitch you have 
chosen. 

The number of characters per inch for each pitch will vary from printer to 
printer. The figures quoted above are valid for most Epson-compatible 
printers. 

T ext can be either justified, with straight left and right margins, as in this 
paragraph: 

In a reference list , with author- date text references 
to it , all works attributed to one person should be 
listed and arranged chronologically by date of 
publication . 

or unjustified, with a straight left margin and a ragged right margin, as in this 
paragraph: 

In a reference list , with author- date text references 
to it , all works attributed to one person should be 
listed and arranged chronologically by date of 
publication . 

Justification is set at the same time as the ruler, and therefore applies to the 
piece of text affected by a particular ruler. 

T o turn justification either on or off, for the duration of a particular ruler, 
select Add ruler from the Layout menu. The Add Ruler dialogue box will be 
displayed. Alternatively, double-click on the ruler icon to display the Modify 
ruler dialogue box. 

C lick on the relevant box to turn justification on or off. 
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If you select Justify ON for a particular ruler, 1st Word Plus will 
automatically inse~t extra stretch spaces between each word as you type, so 
that the righthand margin is straight. (The last line of each paragraph is 
excluded from this process.) Justification is switched off by default on the 
Add Ruler dialogue box. 

If you change justification, you will need to reformat with the F7 key, or by 
selecting Reformat in the Style menu (see the section Reformatting text in the 
chapter Editing documents). 

Centred lines can be produced by positioning the cursor on the line, then 
using F11 or selecting Centre in the Style menu. This will cause the line of 
text to be centred between the left and right margins, like this: 

In a reference list, with author-date text 
references to it, all works attributed to 
one person should be listed together and 

arranged chronologically by date of 
publication. 

1st Word Plus also allows you to align your text with the righthand margin, 
leav ing the lefthand edge ragged. To produce right-aligned text, position the 
cursor on each line, then select Right in the Style menu: 

In a reference list, with author- date text references to 
it , all works attributed to one person should be listed 

together and arranged chronologically by date of 
publication . 

At the end of each line, if the word you are typing goes beyond the right 
margin, it will automatically be carried over to the next line. This feature is 
called word wrap. Since the only time you have to press Return is when you 
want to begin a new paragraph, you don't have to worry about where to end 
each line. This in turn increases your typing speed. Word wrap is switched on 
by default when you load 1st Word Plus. You can turn Word wrap off and 
type in lines up to 160 characters long by clicking on Word wrap in the Edit 
menu. 
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If you switch word wrap off, it will be off for any 1st Word Plus document 
windows you have already opened, and for any new window you open (unless 
you switch it back on again). 

You can control the spacing between lines of text, in increments of one line. 

Line spacing is also set at the same time as the ruler, and therefore applies to 
the piece of text affected by a particular ruler. 

Select Add ruler from the Layout menu. Use the up and down arrows on the 
Line Spacing feature to increase or decrease line spacing to a number 
between 1 and 9. Alternatively, type in the value you want directly. Single 
line spacing is switched on by default when you first load in 1st Word Plus. 

1st Word Plus can hyphenate words for 
length and gtvmg your document 
Hyphenation is switched on by default. 

you, so making better use of the line 
a more professional appearance. 

When a paragraph is reformatted, 1st Word Plus may seek to hyphenate one 
or more words to avoid 'slack' lines with too much white space in them. For 
each word which the program seeks to hyphenate, a dialogue box like this 
will be displayed: 

IIY!henation 

correc-tions 

I Disable I I Cancel I I OK 

If you don't like the way the word is split, click on either the left or the right 
arrow. The hyphen will move along one character at a time. If you cannot 
move the hyphenation point any further to the right, this is because there are 
already as many letters on the left of the hyphen as can be fitted on the line. 
If this means you cannot hyphenate the word to your satisfaction, click on 
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Indenting single lines 

Cancel to move the complete word to the next line. Otherwise, when the 
hyphen is in the position you require, click on OK, and the hyphenated word 
will be inserted into your text. 

A 'soft' hyphen inserted by 1st Word Plus appears on screen as - to 
distinguish it from a 'hard' hyphen you have inserted yourself (as in 'double
click' for example). However, they look the same when printed. 

If you do not want to hyphenate any words in your document, select Disable. 
Alternatively, you can click on Hyphenation in the Edit menu to switch 
hyphenation off (or back on again). 

The gap between the lefthand margin and one or more lines of text is called 
an indent. 1st Word Plus can produce the following types of indents: 

• single-line indents 

• paragraph indents 

• hanging indents. 

In 
references 
should be 
by date of 

a reference list, with author- date text 
to it, all works attributed to one person 
listed together and arranged chronologically 
publication . 

If you want to indent the first line of a paragraph by 5 spaces, you can do it in 
one of two ways: 

• positioning the cursor flush with the left margin on the first line, and 
pressin FlO five times 

• setting the first tab stop to a suitable posttton (see Tabs above), and 
pressin T ab once to move the cursor to the stop. Because T ab in 1st 
Word Ius inserts fixed spaces, you will have to delete them one by one 
if you s bsequently want to get rid of this kind of indent. 

Document layout 67 



68 

Indenting whole 
paragraphs 

Hanging indents 

You may wish to indent whole paragraphs by varying amounts, as in the 

following examples: 

Special problems may be solved by observing the 
following principles . A single- author entry comes 
before a multi - author entry beginning with the same 
name . 

In a reference list , with author- date text 
references to it , all works attributed to one 
person should be listed together and arranged 
chronologically by date of publication . 

T o indent a whole paragraph, press F9 or click on Indent in the Style menu 
one or more times to specify the size of the indent before starting to type in 
the paragraph. (If you use the latter method, use Adjust instead of Select for 
all but the last click to prevent the menu disappearing when you click.) This 
kind of indent looks similar to a Tab indent, but actually consists of a single 
indent space followed by stretch spaces to the next tab stop. The cursor can 
only be positioned on the indent space, and deleting this will delete all the 
stretch spaces. 

This paragraph is indented on each line but the 
first line is further indented by pressing Tab 
immediately after F9 at the start of the paragraph . 

l st Word Plus 'remembers' indents, so you don't need to respecify them when 
reformatting. To change the size of a paragraph indent, first position the 

cursor on the first character in the paragraph. Use H or Delete to reduce the 
size of the indent, or F9 to increase the size, then reformat. 

To indent a whole paragraph which has already been typed, first select the 
first line and press F9, then F7 to reformat the paragraph to the indent. 

You can vary the size of indent produced with F9 by changing the position of 
the tab stops in the ruler; see the section Tabs, above. 

In a reference list , with author- date text references to 
it, all works attributed to one person should be 
listed together and arranged chronologically by 
date of publication . 
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Numbered paragraphs 

The paragraph above has a 'hanging indent'. Type in the paragraph as normal, 
then go back to line 2 and insert an indent with F9. Finally, use F7 to reformat 
from line 2 onwards. A hanging indent will not be preserved if you reformat 
the whole paragraph. This is because 1st Word Plus uses the indent value of 
the first line to work out the left margin when reformatting. 

1.1 In a reference list , wi th author- date text 
references to it , all works attributed to one 
person should be listed together and arranged 
chronologically by date of publication . 

T o number paragraphs, type the paragraph number (or letter) followed by 
one or more F9 indents before the first word in the paragraph. 1st W ord Plus 
will align following text lines with the last indent. 
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1st Word Plus uses three types of page break, or places where a new page of 
printed text starts. These are displayed in the page border on the left of the 
text window, with the new page number directly beneath. Although you can 
work on documents of 100 pages or more, there is only enough room in the 
page border to display numbers up to 99. 

A 'soft' page break is indicated by a dotted line in the page border with the 
new page number appearing directly beneath it. Soft page breaks are 
inserted automatically by 1st Word Plus when the maximum page length is 
exceeded with WP mode switched on. Page length is defined for the whole 
document using the Page layout option in the Layout menu. (For more 
details, see Setting up the margins in this chapter.) You can convert a soft page 
break to a hard page break by clicking on it. 

soft page 
break 

All in all, you will find that 1st Word Plus is a truly 
professional word processor which will ansuer all your writing 
needs. You can 'cut and paste' blocks of text both within and 

''2 between docuMents, and coMbine this with your own gr·aphics. 
There's also a 78,888 word spelling checker and a Mail Merge 
facility . 

1st Word Plus is designed specially for Acorn RISC OS coMputers 
(such as the ArchiMedes range ~nd A3888) so it is ve~y easy to 
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Conditional page breaks 

Insert a hard page break whenever you want the text below it to be printed on 
a new page. 

To insert a hard page break, click on the page border at the point where you 
want the break to occur. A hard page break is indicated by a solid horizontal 
line with the new page number appearing directly beneath it. You can also 
convert a soft break to a hard break by clicking on it. 

Click on a hard page break to delete it, or to convert it back to a soft page 
break. 

hard page 
break 

you will find that 1st Word Plus is a truly 
word pt•ocessor which wi II answer· a 11 your· wl'i t i ng 

'cut and paste' blocks of text both within and 
s, and coMbine this with your own graphics. 

so a 8,888 word spelling checker and a Mail Merge 

A conditional page break is always created by the user (except in footnotes; 

see Printing footnotes in the chapter Editing documents). It is used to protect a 
group of lines that you do not wish to be split across two pages (for example 
a paragraph or a table of figures). If the group of lines crosses a potential 
page boundary, a new page is started at the beginning of the group. 

To create a conditional page break, position the pointer in the page border 
level with the first line of the group and drag down the page border to where 
you want the group to end. While you are holding down Select, the mouse 
pointer turns into a pointing finger, and the scope of the conditional page 
break is indicated by a black oblo~g. 
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Once it has been set up, the conditional page break appears as a very light 
dotted line across the page border with a further dotted vertical line 
indicating its scope. 

conditional 
page break 

-

~ l:JI adfs::Disc3.$.ExanJle2 • .. 
w c .... o .... o .... o .... o .... o .... o ... o .... o .... o .... o .... o .... o .. J if 
H~Ipng Ot' cot't'e~tJng, !h~ug~ ot a vet'Y 11n1te~ kind. ~otTectJng 

fluid can be used to delete text, and ~ou can tyfe over the 
corrections, but you will not be able o insert ext. Moving and 
copying blocks of typewritten text is also very difficult unless 
~ou happen to have a photocopier, scissors and a pot of glue 
andy, 

... With a wot'd Pt'ocessot' like 1st Wot'd Plus, howevet' , {oUt' text is 
·displayed on the screen as vou tf~e it in. It is no printed 
,iMMediately, so you have a brea ing space' in which you can 
.Make as Many corrections as ~ou want. Moving. corying, and 
·deletinr whole sections or ' Jocks' of text 1s a so extreMe!~ 
easy wi h 1st Word Plus. You need only print your text out w en 
you are sure that it is just right, and since 1st Word Plus shows 
you the text exactly as 1t will be printed out, you can be sure 
of perfect results every tine. 

All in all, you will find that 1st Word Plus is a truly 
IPt'ofessiona I wot'd Pt'ocessor which will answet' all yout' writing ~ 

¢ 1¢ ~ 

If 1st Word Plus actually inserts a soft page break at the start position, the 
conditional break indicator changes to a heavier dotted line with the new page 
number directly beneath it. The vertical line showing its scope remains visible. 

You can increase or decrease the scope of a conditional page break by 
dragging the end position to a new place. Delete this kind of page break by 
clicking on its start position. 

1st Word Plus offers you a range of type styles (plain, italic, underlined, 
superscript and subscript) in three different weights (bold, normal and light). 
You can combine and switch between these style options to produce a variety 
of effects: 
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fJ (31 untitled • .. 
W [I I I 101 I I lot I I 101 I I tO I I I tOt I I 101 I I tOt I I tOt I I 101 I I 101 I if 
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~ This line is in plain type 

This line is in italic type 

rhis is underlined 

This is bold type 

T 
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Your printer may not be able to reproduce all the style options available on
screen (see Appendix: Printer drivers for details). 

The type style options can either be selected from the Style menu or by using 
function keys Fl to F6. 

When a style opt ion is switched on, its function key icon will appear 
highlighted and it will be ticked in the Style menu. Everything you type in 
from that point onwards will appear in that style, including spaces. If you 
later delete this text, be careful not to leave 'style spaces', which will then 
pass on their style to anything typed in after them. 

It is not possible to combine either (a) Bold and Light or (b) Superscript and 
Subscript. Selecting one style option (eg Bold) will automatically turn the 
other one (eg Light) off. 

With some word processors, producing underlined groups of words which are 
either centred or indented (for headings, for example) can be a problem, 
since the space before the start of the heading is underlined too. Other word 
processors get round this problem by not underlining any spaces, even those 
between words. However, you can produce fully underlined headings in 1st 
Word Plus by following these steps: 

To underline indented head ings: 

Use Tab or F9 to indent the heading. 

2 Switch on Underline with F2. 
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Changing the case of 
blocks 

3 Type in your text. 

To underline centred headings: 

Switch on Underline with F2. 

2 Type in your text. 

3 Use Fll to centre the heading. 

To produce italic underlined text: 

1 Switch on Underline with F2 and Italic with F3. 

2 Type in your text. 

3 Switch Underline off with F2. 

4 Press the Space Bar. 

5 Switch Italic off with F3. 

6 Carry on typing in your text. 

If you swap steps 4 and 5, the last character of the italic text may appear to 
have a slice out of it on the screen, but it will be printed normally. 

1st Word Plus enables you to change letters, words, or whole blocks of words 
into upper or lower case. First, mark the block you want to change. Then, from 
the Style menu, select 

• Upper case to make the block upper case throughout 

• Lower case to change it to lower case throughout 

• Change case to change all upper case letters to lower case, and vice versa 

• Title word to change the initial letter of each word to upper case and the 
rest to lower case. 

If no block is selected when you choose one of the first three of these options, 
the character at the cursor position will change case. If you choose Title word 
when no block is selected, the letter at the cursor will change to upper case if 
it is the first letter in a word; otherwise, it will change to lower case (if it isn't 
l:)\~·er case already). 
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Printing your document 

Preparing for printing 

Switching printers within 
1st Word Plus 

Like any word processor, 1st Word Plus needs special programs called 
printer drivers in order to print documents on paper; these programs enable 
the word processor to 'drive' a wide range of printers which all expect to 
receive their instructions from the computer in slightly different ways. In 
particular, information coming from the computer about type styles needs to 
be interpreted so that the printer can understand it. 

You cannot use the normal RISC OS printer drivers with 1st Word Plus 
because they are designed for printing graphics, rather than characters; one 
consequence of this is that they run rather slowly with dot matrix printers. 1st 
Word Plus printer drivers, on the other hand, are designed to produce fast 
output from dot matrix printers. 

In order to use all the features which your printer is capable of, you will 
need to install a suitable printer driver for it. A range of drivers for the most 
popular printers is provided on the Utilities disc. If you have a printer which 
is not yet supported by 1st Word Plus, instructions for creating your own 
customised printer driver can also be found in the Appendix. 

Whenever you load 1st Word Plus, it searches in the application directory 
for the defaul printer driver lwp_print, and installs it for use when 
printing. If the default driver is not found, a warning message is displayed 
which you can r~move by selecting CANCEL. 

The 1st Word Plus keypad indicates which printer is currently installed (and 
the output port it is connected to). 

To install a different printer, follow these steps: 

Open a display for the printer driver directory on the Utilities disc. 

2 Drag the icon for the appropriate printer driver onto the keypad. 
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Changing the output port 

Creating a new default 
printer 

Printing your document 

The se lected printer driver will remain installed until you either exit from 
1st Word Plus or se lect another printer. 

To change the output port, click on the port name box in the keypad to switch 

between the parallel (Printer) and serial (Modem) ports or the network 
printer. Your printer manual will tell you which one you should use. 

T o create a new default printer driver ( ie the one that will be loaded 
automatica lly when you start 1st Word Plus), follow these steps (before 
loading 1st Word Plus itse lf): 

• Delete or rename the fil e in the ! lstWo rd+ directory currently called 

lwp_print . 

• Copy the required printer driver file into the application directory and 
give it the name lwp_print . 

(See your computer's User Guide for instructions on copying and renaming 
files. ) 

Before you can print a file, you must save it. Then drag its icon from the 
directory viewer onto the printer icon in the keypad. The following dialogue 
box will appear: 

Print file 

Print Pages fro~ [][!][!] 
to [ill][!][!] 

Page nu~ber offset OJ[!][!] 
Left ~argin offset [][!][!] 
Alternate left ~argin OJ[!][!] 
Nu~ber of copies [][!][!] 
c=]Swap headings on alternate pages 
c=]Pause between pages 

Print quality: <!>Draft (>NLQ 

I Cancel! I OK I 
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Page number offset 

Left margin offset 

Alternate left margin 

Swap headings on 
alternate pages? 

Print quality 

C lick on any of the number boxes to move the cursor bar into it so that you can 
change the number. Many of these are se lf-explanatory; those that are not are 
described below. 

This field can be used to control the page numbers that appear in the 
document as it is printed. This is a very useful feature if you are printing a 
series of files, such as chapters in a book. If chapter 1 ends at page 50, type in 
'50' as the page number offset for chapter 2, and the first page number 
printed will be '5 1'. 

This number tells the printer how many character positions to move the print 
head across the platen before it begins printing. You may need a left margin 
offset to avoid the row of perforations on the edge of fanfold printer paper, 
or because you have an offset sheet feeder. 

This field allows you to set a different width of left margin which will be 
used for the even-numbered pages in your document. The width set in the 
previous instruction will then only be used for the odd-numbered pages. If, 
for example, you are printing a document that is to be photocopied onto both 
sides of the paper, and you want a wider margin near the binding of this 
document to allow you to punch holes there, the wider margin will need to be 
at the left on odd-numbered pages and at the right on the even ones. Although 
you cannot actually set the right margin as such, you can do so indirectly by 
varying the width of the left margin. Careful select ion of the size of the two 
left margins can be used to create the desired effect. 

If you se lect Yes, the left- and righthand components of your header and 
footer lines will be reversed on even-numbered pages, allowing you to print 
double page layouts. This facility is often combined with the use of the 
Alternate left margin facility above. ('Even-numbered' here refers to the 
page numbers '2', '4', '6', etc. actua lly printed on each page, not the physical 
pages 2, 4, 6, etc.) 

If you have installed a near letter quality (NLQ) dot matrix printer, this 
option allows you to select either draft or NLQ print. 

If you have installed a daisywheel printer, then selecting NLQ mode will 
make the printer pause whenever it is asked to print italic or light text. The 
printer driver will prompt you to change daisywheels at each sty le change. 
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Make sure your printer is properly connected, switched on, 'on line', and 

loaded with paper. Check your selections on the Print file dialogue box, then 
select OK. 

While the file is being printed, the printer icon on the keypad changes to 
read 'Status'. C licking on this box displays the Print status dialogue box. 

Print status 

adfs: :Disc3.$.Exa~ple 

Epson FX (9-pin ~atrix) 

File 

Printer 

Copies 

Page 
1 I ._I --;:::;;;;::::;~P;::r;;:::i n=h=· n:;-9 -;::::::;;::;:::~---' 
2 I OK I I Pause I I Stop 

The Print status dialogue box displays the following informat ion: 

• the name of the file you are printing 

• the name of the printer driver installed 

• the number of copies you have selected 

• the number of the page currently being sent to the printer 

• the current status of the printer: 'printing' or 'paused'. 

T o remove the Print status dialogue box and continue printing without doing 
anything else, click on OK. 

T o interrupt printing, select the Pause box. Printing may not stop 
immediately; this will depend on the size of the buffer in your printer. 
Printing will continue until it reaches the page number displayed in the Print 
status box. When you click on Pause, the dialogue box will disappear. To 
restart printing, click on 'Status' in the keypad to display the Print status 
dialogue box again, and click on Restart. 

If you chose Pause between pages on the Print file box, the Print status 
dialogue box will appear automatically when printing pauses, showing 
Restart in the centre box to allow you to insert a new sheet of paper. When 
you are ready, click on Restart. 

To stop printing altogether, click on Stop. The Status box on the keypad will 
change back to read 'Print file '. 
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1st Word Plus menus 

Displaying the menus 

This chapter summarises, menu by menu, all the things you can do with 1st 
Word Plus, which have been described in the preceding chapters. 

The top-level menu appears when you press Menu on the mouse, provided the 
pointer is over a 1st Word Plus document window or the keypad window. 

lstMord+ 
Save o(> 

Edit <> 
Select o(> 

Layout o(> 

Style <> 
Spelling o(> 

Graphics o(> 

Help <> 

1st Word Plus menus are organised in the same hierarchical way as other 
RISC OS menus, and have the following features: 

• An arrow to the right of a menu option indicates that a submenu will 
appear when you move the pointer onto the arrow. 

• An option with three dots to its right will display a dialogue box when it 
is selected. These dots are not shown as part of the option names printed 
in this Guide; this is simply for the sake of readabilitv. 

• An option without arrows or dots represents an action that will be carried 
out when you click on it. 

• Some options represent features that can be on or off; they are marked 
with a tick when they are on. 
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The save menu 

The edit menu 

Find 

80 

• Some options have keystroke alternatives, which you will find useful when 
you are familiar with 1st Word Plus. These are shown to the right of the 
option. The A character stands for the Control key, which should be held 
down while you press the other key indicated. A ll the keystroke 
alternatives are listed in the next chapter. 

• Options that are not currently available - usually because some necessary 
preceding action has not yet been carried out- are shown in grey. 

This leads to a submenu containing two options: File (for saving the complete 
document) and Selection (for saving a marked selection as a separate file) . 
Each of these leads to a normal RISC OS Save as dialogue box. T o save the 
file or selection, ed it the filename to what you want, then drag the icon to the 
directory where you want to save the file. If you are re-saving a document that 
has already been given a full pathname which you don't want to change, you 
can just click on OK, or press Return. 

Edit 
Find... ftF2 
Replace . .. ftF3 

Statistics ... ftz 

.J WP 111ode 

.J Hyphenation 

.J Insert 111ode 

.J Word wrap 
-------------------
Set filar.k ¢ 
Goto 111ark ¢ 
Boto page •.. ftG 

Select this option to search for a spec ific string of text in your document. If 
the string is found , the cursor will be placed either on the first character of 
the string (backwards search) , or on the chacacter immediately after the string 
(forwards search). If th.e string is not found, the cursor will be placed at the 
start or end of the document, depending on the search direction. Find is 
described in detail in the Editing documents chapter. 
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Repeat find 

Statistics 

WP mode 

Hyphenation 

Insert mode 

Word wrap 

Set mark 

Select this option to search for a specific string of text in your document and 
replace it with a second one. If you specify replacement of One or All 
matches, Replace will search and replace automatically. If you spec ify 
replacement of Some matches, Replace will find and display each match and 
ask you whether to replace the string, continue without replacing, or cancel the 
search. If the search string is not found, the cursor will be placed at the start 
or the end of your document, depending on the search direction. 

Select this option to repeat the last Find or Replace automat ica lly, using the 
same choices. If the last Find or Replace finished at the start or the end of 
your document, then the search direction will be reversed for Repeat find. 

Select this option to display a dialogue box showing the number of pages, 
lines, and words in the current document, as well as its size in bytes. 

Use this option to switch Word Processing mode on and off. 

Switch WP mode off only if you want to work on non-document files; they 
will then be stored as plain text. 

This option allows you to switch automatic hyphenation on and off. If you 
switch hyphenation on, 1st Word Plus will try to hyphenate long words when 
you reformat. This option is only avai lable in WP mode. 

Select this option to switch insert mode on and off. If insert mode is switched 
off, any new text you type in at the cursor position will overwrite the existing 
text. If it is switched on, existing text will move to the right when new text is 
typed in. 

Select this option to switch word wrap on and off. With word wrap switched 
on, text is moved onto the next line when you go past the right margin. With 
word wrap switched off, the right margin is ignored, and you can continue 
typing on the same line until you press Return or reach the 160 character 
limit. This option is only ava ilable in WP mode. 

Use this option to set or redefine up to four position marks anywhere in your 
document. Marks are set at the current cursor position. 
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Goto mark 

Goto page/Goto line 

The select menu 

Start 

End 
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This option moves the cursor to one of the position marks defined by the Set 
mark option. 

This option allows you to move the cursor to the top of a given page in your 
document. If you specify a page number greater than the number of pages in 
your document, the cursor will be placed at the top of the last page. This 
option becomes Goto line in non-WP mode. 

The options in the Select menu allow you to create and work with selections 
of text and/or pictures. Selections are sections of a document of any length. 
Areas of text within them will be highlighted with a black background. A 
document can have only one selection marked at any time; marking a second 
selection will cause the first selection to be cleared. 

Select 
Start ~s 

End ~E 

Cut ~F7 
Copy ~c 

Moue 
Clear 
Find start ~r 
Find end ~B 

Select this option to define or redefine the start of your selection at the 
current cursor position. 

Select this option to define or redefine the end of your selection at the current 
cursor position. An alternative method of redefining the end of a marked 
selection is to double-click Select where you want the new end to be. 

Although selection start and end positions must be inside the window when 
they are defined, 1st Word Plus will remember selection positions when they 
move off screen. Once a selection has been defined, it will be highlighted and 
will remain so until you use Clear, Cut, or Reformat. 
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Cut 

Copy 

Paste 

~ 

Move 

__, 

_.., 
Find start 

,_.., 
Find end 

Clear 

,......... 

,......, 

Use this option to cut a marked selection from your document and copy it onto 
the clipboard. A dialogue box will appear when the selection has been 
copied. When you click on OK, the selection will be cut from your document. 
The contents of the clipboard can later be pasted back into your document at 
any point. Should you try to copy another selection onto the clipboard before 
its existing contents have been pasted back into the document, a warning 
message will appear. 

This option copies a marked selection to the clipboard without cutting it from 
your document. Copy will overwrite the clipboard contents in the same way as 
Cut. 

This option pastes in a copy of the clipboard contents at the cursor position in 
the current window. The contents of the clipboard remain intact, so you can 
paste the selection in at more than one position in one or more documents. 

This option moves the marked selection to the current cursor pos1t10n in the 
same window. Move uses the clipboard, and will therefore overwrite any 
existing contents it may have. 

Use this option to move the cursor to the start of the marked selection. 

Use this option to move the cursor to the end of the marked selection. 

This option removes the highlighting and start and end markers from a 
selection. The contents of the clipboard are unaffected. Using Reformat or F7 
or pressing and holding down Select will also clear a selection. 
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The layout menu 

Show ruler 

Show position 

Page layout 

Add ruler 

The options provided in this menu are described fully in the chapter Document 

layout. 

layout 
.J Show ruler 

Show position 

Page la':lout ... 

Rdd ruler... ~R 

Footnote for~at. :. 
Rdd footnote ... ~F4 

This option allows you to turn the ruler line display at the top of the text 
window on and off. 

This option allows you to turn the cursor position display at the top of the text 
window on and off. If WP mode is also switched on, details are given of the 
page, line and column where the cursor currently appears. If WP mode is not 
switched on, only the line and column will be given. The cursor position is 
displayed in place of the ruler line, and vice versa. You can create an extra 
line in the text window by turning both Show ruler and Show position off. 

Select this option to display a dialogue box allowing you to specify the 
header and footer lines and page layout for your document. 

Select this option to insert a new ruler into your document at the current 
cursor position. Rulers can only be added in WP mode, and will control the 
following options: 

• character pitch (the number of characters per inch) 

• spacing between tab stops 

• tab leader character 

• ruler length 

84 1st Word Plus menus 



Delete ruler 
r - -; 

Footnote format 

Add footnote 

The style menu 

Type style options 

• justification 

• line spacing. 

Select this option to delete the ruler controlling the current cursor position. 

Select Footnote format to display a dialogue box allowing you to format the 
rule separating the footnotes from the main body of the text. The length of the 
rule is measured in character widths and the pitch of these characters is taken 
from the footnote ruler. 

Select Add footnote to add a footnote at the cursor position. You can add 
footnotes wherever you like, except in header lines, footer lines, or in 
footnotes themselves. 

The Style menu is used to select type style options and some text formatting 
features. 

Style 
.J Bold F1 

Underline F2 
ltal ic F3 
Light F4 
Superscript FS 
Subscript F6 

Centre 
Right 
Indent 
Reforfilat 
Upper case ftu 
Lower case ftw 
Change case ftu 
Title word ftX 

Use one or more of these options to turn the various features on or off. When 
selected, the style will apply to text that you type in at the cursor, or to a 
marked selection. 
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Alignment options 

Reformat 

Case options 

The spelling menu 

Load dictionary 
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Select one of Centre, Right or Indent according to how you want your text to 
be aligned. For full details, see the Document layout chapter. 

Select an option from the Reformat menu whenever you have: 

• changed your text by deletion or insertion 

• altered the size of an indent 

• switched justification on or off 

• modified the right or left margin 

• inserted a new ruler. 

You can reformat single paragraphs, the text between two rulers, or the whole 
document. You will not be able to reformat any text created with · WP mode 
switched off, since all spaces will be fixed spaces. 

Select Upper case or Lower case to change the case of a selection throughout. 
Select Change case to swap the case of each letter, and Title word to put the 
first letter of each word into upper case and the rest into lower case. If no 
selection is marked, the appropriate change will be made to the single 
character at the cursor position. 

For more detail on these options, see the chapter Editing documents. 

Spelling 
Load Dictionary 

, " .,,. • • • .. fSC 
Co~tinuoJ~ spel:ing 
Br·owse. . . "rs 
Add word "F6 
fnd <;pPI] C'lPCk 

Select this option to load in the main spelling dictionary from the same 
directory and disc as the program. 
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Check spelling 

Continuous spelling 

Browse 

Add word 

Select this option to check the spelling in your current document from the 
cursor position onwards. 1st Word Plus will flag any word it does not 
recognise by placing the cursor after it. You then have the choice of adding the 
word to the dictionary (if it is correctly spelled but not yet included), or of 
replacing the word in your document (if it is incorrectly spelled) using either 
the normal editing process or the Browse option. 

Select Check spelling again or press Escape to continue the spelling check 
after making the necessary amendment. 

This option allows you to check the spelling of each word as you type it in. 
When you move the cursor off a word that is not listed in a currently loaded 
dictionary, either by typing a space after the word , or by using the cursor keys, 
your computer will warn you with a beep so that you can check the spelling. 
Click on the option a second time to switch it off. 

Select this option to display the dictionary browser, which will allow you to: 

• correct spelling mistakes in your documents automatically 

• add new words to the dictionary 

• scan the dictionary for unwanted entries. See the chapter Editing documents 
for details of how to delete these entries. 

The dictionary browser displays a group of ten words at a time on screen. 
Use the up and down arrows to the left of the word group to search through 
all the words in the spelling dictionary beginning with the same letter as the 
word on the Find line. 

To check the spelling of a word that is not in your document, type it in on the 
Find line, then click on the Find box. If the Find line already contains an 
unwanted word, clear it by pressing Ctrl-U before entering the new word. 
The program will search for the word you have specified and display the 
relevant part of the dictionary. If the word is in the dictionary, it will be 
highlighted at the top of the browser. 

This option allows you to add new words directly to the supplementary 
dictionary. The word that is added will be the last word that the spelling 
checker detected as missing from the currently loaded dictionaries, unless you 
have altered the Find line of the browser after that word was detected, in 
which case it will be the word that currently occupies the Find line. 
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End spell check 

The graphics menu 

Graphics mode 

Delete picture 

The help menu 
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Use this option to finish a session of checking your spelling or add ing words 
to the supplementary dictionary. A dialogue box will be displayed to allow 
you to save the altered supplementary dictionary onto disc. Select NO to 
abandon any additions you have made. 

For full details of these options, see the Editing documents chapter. 

GraPhics 
Graphics 111ode 

Delete picture 

This option allows you to switch graphics mode on and off. You may want to 
switch it off in order to save memory or to avoid confusion when ed iting text 
that is overlaid by graphics. When you first load a picture graphics mode 
will automatically be switched on to allow you to paste pictures into your 
documents. 

Position the cursor on one of the lines contammg the picture you want to 
delete, then select this option. The picture will be highlighted, and 1st Word 
Plus will ask you to confirm that you want to delete the selected picture. If 
there is more than one picture on the line the program will select the first one 
it finds. If this is not the one you wish to delete, you may have to move the one 
you want to a line with no other pictures on it before you can delete it in this 
way. 

The Help menu displays a list of topics for which on-screen help is available. 

Above this list, the 1st Word Plus option tells you the vers ion number of your 
copy of the application. Extra help, when selected, causes a message to 
appear when you se lect any menu option, summarising what effect that option 
will have and allowing you to change your mind about selecting it. 
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Keystroke equivalents 

When typing and editing 

When using selections 

Many 1st Word Plus selections can be carried out in more than one way. The 
three possible alternatives are 

• selecting from a menu with the mouse 

• pressing a key or combination of keys on the keyboard 

• clicking on a box in the on-screen keypad. 

The summary in this chapter lists these alternatives menu-by-menu (with, in 
brackets, a few options which cannot be carried out from menus), inqicating by 
each one which keystrokes achieve the same effect. Options th1t can be 
selected by clicking on the keypad are marked with a tick./. 

Find 
Replace 
Repeat find 

Show statistics 

(Delete line) 

Goto page (in WP mode)/ 
Goto line (in non-WP mode) 

(Insert fixed space) 
(RISC OS command line) 

Start 
End 
Cut 
Copy 

Keystroke equivalents 

Ctrl-F2 
Ctrl-F3 
Ctrl-Fl 

Ctrl-Z 

F8 ,/ 

Ctrl-G 

FlO,/ 
F12 ,/ 

Ctrl-S 
Ctrl-E 
Ctrl-F7 
Ctrl-C 
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Paste Ctrl-F9 
Move Ctrl-FlO 
Find start Ctrl-T 
Find end Ctrl-B 
Clear Ctrl-K 

In the layout menu Show ruler Ctrl-L 
Show position Ctrl-P 
Add ruler Ctrl-A 
Delete ruler Ctrl-0 

Add footnote Ctrl-F4 

When changing Bold Fl ./ 
typestyle Underline F2 ./ 

Italic F3 ./ 
..--, 

Light F4 ./ 
Superscript FS ./ 
Subscript F6 ./ 

Centre text Fll ./ 
Right align text Ctrl-Fll 
Indent F9 ./ 
Reformat paragraph F7 ./ 

Switch to upper case Ctrl-U 
Switch to lower case Ctrl-W 
Swap case Ctrl-V l 
Title (initial upper case) Ctrl-X 

During spell-checking Check spelling Escape 
Browse Ctrl-FS 
Add word Ctrl-F6 
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Introducing 1st Mail 

What is 1st Mail? 1st Mail is a mail merge program for use with 1st Word Plus. A mail merge 
program allows you to produce a series of documents which differ from each 
other only in certain details. This kind of program is typically used to 
address the same letter to a number of different people. Two files, one 
containing the letter and the other the names and addresses, are merged, 
hence the name 'mail merge'. 

For example, if you work in the marketing division of a large company, you 
might want to send a letter to . all your customers announcing a new product. 
To do this with 1st Mail, you would first create a master document with 1st 
Word Plus. This is the part that is common to all the letters: the message 
itself. 

The part that is different in each letter is the variable 
customers' names and addresses. Use 1st Word Plus 
containing this variable data; we call this the datafile. 

data, such as the 
to create a file 

By merging the variable data for each customer into the master document, 1st 
Mail creates a series of personalised letters, although you have only needed 
to type the letter once. 

Of course, you are not restricted to producing letters with 1st Mail. You can, 
if you wish, use it to produce multiple copies of any document, such as party 
invitations or office memos. 
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master 
document file datafile 

D 0 

D 
standard letter + personal data personal letters 

The rest of this chapter provides an introduction to 1st Mail and tells you how 
to run 1st Mail on your Acorn computer. 

The next chapter, More about I st Mail, describes the more advanced features 
of the program. 

1st Mail is supplied to you on the 1st Word Plus Program disc. Before using 
it, you should make a working copy of the Program disc and put the original 
away in a safe place. If you have a hard disc, copy the contents of the Program 
disc onto it. You will find instructions for both of these processes in the User 
Guide supplied with your computer. 
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Installing a printer driver 

Load 1st Mail in the normal RISC OS way, by double-clicking on its icon in 
the directory display. The 1st Mail icon will appear towards the righthand 
side of the icon bar. 

Before you can use 1st Mail, you need to install a printer driver (or that you 
want to save the output as a file). 

To do this, press Menu on the 1st Mail icon bar icon, and select Printer. The 
following dialogue box will appear: 

Printer installation 

The printer currently installed is 
Standard backspacing printer 

To install a new printer driver, drag it 
to this window 

!Parallel Port I 

I Cancel I OK 

This enables you to tell 1st Mail two things: 

• whether you want to print your output or save it as a file, and broadly 
what type of printer you have 

• the specific printer type, such as an Apple LaserWriter or Epson LX-
compatible dot matrix. 

Clicking on the lower box repeatedly offers you, in turn, the following options: 

• Serial port if you have a laser printer connected directly to your computer 

• Parallel port if you have a dot matrix printer connected directly to your 
computer 

• Network port if you are printing via a network 

• File if you want to save your output as a file. You may want to do this so 
that you can check your output before printing it. 

When the option you want is displayed in the box, stop clicking. 
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1st Mail guided tour 

Looking at a master 
document and datafile 

To install a specific printer driver, open a directory display for the directory 
containing printer drivers (lwp_ Print .Config on the Utilities disc), and 
drag the icon for the one you want onto the Printer installation dialogue box. 
Its name will appear in the upper white box. If you selected File in the lower 
box, you don't need to do this. 

When you have made your selections, click on OK. 

If you chose File as your option, a normal RISC OS Save as dialogue box 
will appear when the merge starts. Type in the filename you want for your 
output, and drag the icon to the directory display for the directory where you 
want to save the file. 

Your 1st Word Plus disc contains examples of a master document and a 
datafile, to help you get to know the basic features of the program. This will 
give you an overview of how 1st Mail works, before you get down to creating 
your own master documents and datafiles. 

First of all, have a look at the master document by loading it into 1st Word 
Plus in the normal way. You will find it on the Program disc, in the directory 
lml docs, with the filename letter. It looks like this: 
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"PROCESSING YOUR LETTER TO II 

are pleased to infor~ ~ou that 1st Mail is now available for 
e with 1st Word Plus. We believe ~any of the custo~ers of 
~ r will like the advanced features offered by 1st Mail, 

nc uding the auto~atic refor~atting of paragraphs with 
nsertions in the~. For further details, contact your local 

Ot'n De a 1 er. 

sincerely, 

McRdda~s 

There are several lines at the top that start with words in light type. These are 
explained in more detail later; you don't need to know about them for this 
session. Then follows the 'greeting' line: Dear ...... This will be filled in by 1st 
Mail with the title and name of the person you are writing to. 

The main text of the letter comes next; you will see that although most of it is 
in normal type, the word 'company' in the third line is in light type. Again, 1st 
Mail will substitute the name of the company, which it will take from the 
datafile. 

Now close the document window, and open a directory display for the file 
addresses, which you will find in the lml_data directory on the Program 

disc. Load this into 1st Word Plus so that you can see what it looks like: 
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Running a mail merge 

It consists of a series of lines (each line is called a record), each line 
containing data about one person who is to receive the letter. 

When you run a mail merge, 1st Mail reads the first record from the datafile 
and inserts the relevant parts of the name and address into the master 
document to create a personalised letter. It then does the same with the 
second record, and so on until it has read all the records in the datafile. 

To run a mail merge using the example files supplied, take the following 
steps: 

Load 1st Mail by double-clicking on its icon in the directory display. 

2 Press Menu on the icon that appears on the icon bar, and select Printer, 
as described above. Click on the lower box until you see the appropriate 
entry for your printer; then click on OK. 

3 Open the directory containing printer drivers ( 1 wp _Print . Con fig on 
the Utilities disc). 

4 Drag the appropriate printer driver icon onto th-;; Printer installation 
dialogue box. 

5 Now open a directory display for the directory lml Docs, which contains 

the master document. 

6 Drag the icon for the file letter onto the 1st Mail icon on the icon bar. 
This tells 1st Mail you want to use letter as your master document. 
Your screen will then look like this: 
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I 
Print pages fro" 

to 
[][!]@] 
~@]@] 

Page nulllber offset []@]@] 
left ..argin offset []][!]@] 
Alternate left ~~argin []@]@] 
Nulllber of copies 

Nulllber of colu~s 

lii!iG IJ:=ill ~ 
:4 :1 Econet 

[]@]@] 
[]@]@] 

[:)Swap headings on alternate pages 
[:)Pause between pages 

Print quality: <$>Draft 0 NLQ 

IHeaderstfooters ruler! 

~I 

7 For this session, there is no need to change any of these values, so you can 
go straight ahead and click on OK 

8 The Print file window wi ll disappear, and the following text will appear 
in the 1st Mail window: 

1st Mail letter started 
DATA FILE 

9 1st Mail is now waiting for you to tell it the name of the datafile. You 
can do this in two ways: 

• Type the full pathname of the datafile, and press Return. 

• Open a window for the directory containing the datafile, and drag the 
datafile's icon onto the 1st Mail window. To do this, you may need to 
shrink the 1st Mail window so you can see more of the screen behind; 
do this in the normal RISC OS way, by dragging on the Adjust size 
icon on the bottom right of the window. 
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Looking at the merged 
output 

The master document 
in more detail 

10 1st Mail will now carry out the merge, giving you messages as it_goes 
along to tell you how far it has got. 

Your printer will produce four merged copies of the letter you just created 
when you ran the mail merge. 

The first merged letter will look like this: 

Mr A.B. Winters 
Rouse, Waken & Co Ltd 
125 King Street 
Ware 
SG8 6BD 

Dear Mr Winters, 

We are pleased to inform you that 1st Mail is now 
available for use with 1st Word Plus. We believe many 
of the customers 6f Rouse, 0aken & Co Ltd will like 
the advanced features offered by 1st Mail, including 
the automatic reformatting of paragraphs with 
insertions in them. For further details, contact your 
local Acorn Dealer. 

Yours sincerely, 

Douglas C. McAddams 

Each customer in your imaginary mailshot would get a similar letter, but with 
a different name, company, address, and so on. 

Notice how 1st Mail has reformatted the main paragraph of the letter to 
accommodate the varying lengths of the 'company' name that it inserted. 

Load the master document into 1st Word Plus again so that you can look at it 
in more detail. 

You saw before that the example document has a number of sections which 
are distinguished from the surrounding text by being in light type. These 
pieces of light text fall into two groups: keywords and commands. There is a 
fixed set of commands in 1st Mail, but keywords are determined by the user 
and there can be as many as you like. The only restriction is that they must not 
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Introducing keywords 

1st Mail commands 

be the same as any of 1st Mail's commands. Keywords and commands can be 
in upper case or lower case, as long as they are in light type. A complete list 
of commands appears in the chapter 1st Mail commands. 

We will look at keywords and commands in turn to see how they are used. 

Whenever 1st Mail comes across text in light type it first tries to identify it as 
a command. If it cannot do so, it will treat it as a keyword. A keyword is a 
prompt for the mail merge program to look for a piece of individual data to 
insert in a merged document. When you are typing in a master document, you 
will need to use keywords in all the places where you want 1st Mail to insert 
pieces of data, usually from a datafile. The keywords used in the example 
master document are as follows: 

tit le 
i ni t ials 
name 
company 

address 
city 
post code 

The pieces of personal or variable data which correspond to these keywords, 
and which appear in the first sample merged letter above are as follows: 

Mr 
A.B. 
Winters 
Rouse, Wak e n & Co Ltd 

125 King Street 
Ware 
SG8 6BD 

You can use as many of your own keywords as you like, provided that each 
keyword corresponds to a piece of data. 

Light type is also used to identify commands embedded in the master 
document. The commands used in the example master document are read, 
r agged, omitblank, and display at the top, and repeat at the bottom. 
You will notice that each command is at the beginning of a line, and that there 
is only one command on each line. All commands included in 1st Mail 
documents must be at the start of a line and there must not be more than one 
to a line. 

We will now look at each of the commands used in the example master 
document in turn, starting with the group of commands at the top. 
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Read 

The read command tells 1st Mail to read in data fields from a datafile and 

associate each one with the corresponding keyword in the master document: 

read title, initials, name, company, 

1st Mail will then go to the first record in the named datafile (here 
addresses ) and link up the data in each field with the keywords in the line, 
following the read command in exactly the same order: 

Mr , A . B ., Winters ," Rouse , Waken & Co Ltd", 

After this, whenever 1st Mail comes across the word title in light type, it 
will inse rt the piece of data Mr until it receives the next read command. The 
same process will be repeated for every keyword which 1st Mail encounters, 
and for which it has read a piece of data. 

Note: Keywords must be in ordinary plain type when they are being 
defined following the read command, but in light type when they are to 
be used within the master document. 

Ragged 

The next command in the example master document is ragged, which 
specifies a ragged (unjustified) right margin: 

We are pleased to inform you that 1st Mail is now 
available in the UK for use with 1st Word Plus. We 
believe that many of the customers of 

1st Mail will default to the type of margin in force in 1st Word Plus when 
you made your master document. If you want to change the setting for all or 
part of your merged letter, use the commands ragged or justify at the 
appropriate places to override the original setting. This is the same piece of 
text in justified form: 

We are pleased to inform you that 1st Mail is now 
available in the UK for use with 1st Word Plus. We 
believe that many of the customers of ... 
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Omit blank 

Following ragged in the example master document is the command 
omitblank. This tells 1st Mail that if a data field is empty for some reason, 
a blank line is not to be printed in -place of the corresponding keyword in the 
text . One of the records in the sample datafile has no data field 
corresponding to the keyword address, but simply reads: 

Ms , J . C ., Crow ,"Curl Up and Dye", Oxford , OXl 2PO 

If you specify omitblank in your master document, 1st Mail will print this 
address as follows: 

title initials name 
company 
city 
post code 

Ms J . C. Crow 
Curl Up and Dye 
Oxford 
OXl 2PO 

and the other addresses in the usual way: 

title initials name 
company 
address 
city 
post code 

Mrs J . Rivers 
Freshwater Fisheries 
25 Old Square 
Edinburgh 
ENl SHQ 

If, on the other hand, you would like the addresses on all your letters to start 
and end in the same place on each page, use the command noomi t to 

produce the following result: 

title initials name 
company 

city 
post code 

Ms J . C . Crow 
Curl Up and Dye 

Oxford 
OXl 2PO 

If you do not specify a choice, 1st Mail will print blank lines when a field is 
empty; in other words, noomi t is the default. 
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Display 

The final command at the top of the example master document is of a 
different kind from the other commands. This command does not have any 
effect on the contents or the layout of each letter, but displays a message on 
the screen: 

display "PROCESSING YOUR LETTER TO title name" 

The message in the example master document indicates which letter is 
currently being processed by 1st Mail. 

Repeat 

At this point, 1st Mail has carried out all these commands using the first 
record it encountered in the datafile addresses. Without any further 
instructions, the program would simply stop, having produced one letter. The 
repeat command tells 1st Mail to go back to the very beginning of the 
master document and read through it again, using the next record. The 
program will then carry on repeating this process until it runs out of data. In 
the example used here this results in four letters, because the datafile has 
only four records. 

The commands contained in the example master document have instructed 1st 
Mail to: 

Read a set of data fields into the letter in place of the specified 
keywords. 

2 Omit any blank lines where a data field is empty. 

3 Make the right margin ragged (unjustified). 

4 Display a message on screen indicating that 1st Mail is processing a 
letter to the name of the person contained in the first record of the 
specified datafile. 

5 Repeat steps 1-4 with each record in the datafile. 

You will, of course, want each merged letter to start on a new page; the hard 
page break before the repeat command ensures that this will happen. It is 

also likely that you will not want a page number to be printed on a one-page 
letter, so the Page layout dialogue box in the example letter has been used 
to remove the page number from the footer line. 
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The sample address list datafile you used in the tutorial (created with 1st 
Word Plus) is included on the 1st Mail program . disc. You will see the 
following list: 

Mr , A. B., Winters ,'' Ro use , Waken & Co Ltd '', 125 King Street , Ware , SG8 680 , 
Ms , J . C., Crow," Curl Up and Dye ",; Oxford , OXl 2PO , 

Dr , A., Daley , McCann Enterprises , 6a Railway Close , London , EC l 4FU , 

Mrs , J ., Rivers , Freshwater Fisheries , 25 Old Square , Edi nburgh , EHl SHQ , 

The datafile consists of four records, with each record containing the variable 
data to be used in one merged document. Within each record, the pieces of 
data or fields are separated by commas. No space is left between the comma 
and the following item; such a space would appear as a space before that 
item in the text of the letter itself. 

Each record must contain the same number of fields as there are keywords 
following the word read at the top of the master document, although some of 
the fields may be empty (look again at the second line in the example, which 
has no address field). 

Notice the comma at the end of each line in the data file. The master 
document has eight fields following its read command, including c o untry, 
but none of the records in the datafile has an entry in the country field. The 
comma at the end of the line indicates to 1st Mail that this field is not 
present, and that it should go on to the next record. 

Any data field which itself contains a comma must be enclosed in double 
quotes, or the program will take the position of the comma as the end of a 
data field. 

If you use 1st Word Plus to create a datafile, it is essential that it is stored 
in non-WP mode! You can also use a plain text editor such as Edit to create 
datafiles. 
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More about 1st Mail 

Command files 

This chapter is a reference guide to creating mail merge documents using data 
files and command files. Some of these features have already been covered 
in the tutorial session in the previous chapter. The previous chapter also 
provides definitions of terms such as keyword, command, field and record used 
here. 

If you use mail-shots in your business - or give a lot of parties - 1st Mail will 
save you a great deal of work, even if you only use it in the way described in 
the previous chapter, that is, explicitly telling 1st Mail which letter file and 
which datafile to use for each merge operation. However, you can make life 
easier still by using command files. 

Suppose Rouse, Waken & Co mail all their clients once a month to tell them 
about new services on offer. The company keeps a database of clients' names 
and addresses, which of course changes from time to time, but is always saved 
with the same name - clients. A command file could incorporate the 
information that the datafile is always clients, but ask the operator, when 
the merge is run, for the name of the new letter file it should use. It can also 
ask the operator to enter the date, which it will then assign to a keyword and 
use in the mailing. 

You can also use a command file to run together a series of merge operations 
into a single session. 

A command file is run in the same way as an ordinary master document: by 
dragging it onto the 1st Mail icon on the icon bar. 

A sample command file created with 1st Word Plus is supplied on the 1st 
Word Plus program disc, with the name lml docs. command. It contains the 

following text: 
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datafile addresses 
input "today's date? " todaydate 
input "letter filename? ", letter 
includefile letter 

By following the workings of this small command file step by step, you will 
be in a better position to learn how to write command files to carry out more 
complex mail merge tasks of your own. 

The datafile command tells 1st Mail to use the named datafile whenever 
the read command is encountered. 

When you run the command file, 1st Mail will check that the datafile you 
have specified actually exists on disc, and will display an error message if it 
cannot be found. If you do not specify a filename in the command file, 1st 
Mail will display the prompt DATAFILE, and wait for you to either type in 
the name of the datafile, or drag the datafile's icon onto the 1st Mail window. 

If you specify a datafile by typing in its name, and it is not in the current 
directory, you will need to specify a full directory path to enable the 
program to find it. If you are not sure how to use filenames and pathnames, 
refer to the User Guide supplied with your Acorn computer. 

The input command used in the next two lines of the example command file 

tells 1st Mail to display the text between the quotation marks on the screen 
and wait for a reply: 

input "today's date? ", todaydate 
input "letter filename? ", letter 

1st Mail will then · take the reply and identify it with the keyword (eg 
todaydate) after the comma. Whenever 1st Mail subsequently encounters 
the keyword in this mail merge session, it will substitute the reply that was 
typed in. 

This is an interactive command, since it asks you to enter information while. the 
program is working. 
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lncludefile 

As with datafiles, if you wish to name a file in one. of your answers, and that 
file is not in the current directory, you must precede its name with a directory 
path which will allow the program to find it, or drag its icon from the 
directory display onto t~e 1st Mail window. 

The last line in the command file: 

includefile letter 

tells 1st Mail to look for the file letter and process it. Once 1st Mail has 
processed the file, it will return to reading the instructions in the original file . 
In our example command file, there are no further instructions, so the 
program will stop at this point. 

If the includefile command is used with no filename following it, lst 
Mail will display the prompt INCLUDEFILE, and wait for you to supply it 
with a name. Do this in exactly the same way as for a datafile. 

The following diagram shows the effect of the includefile command in 
the middle of a file. 1st Mail will stop processing file A and start processing 
file B. When it has finished processing file B, it will return to file A and 
carry on processing it. 

FILE A 

FILE 8 

includefile 

,..------3> 

l 
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If file A is a command file, the document processed by the inc l udefile 
command will be separate from the command file itself. By using one 
includefile command after another, you can process as many sets of 

documents as you wish. For example, the following command file will 
process the file associated with the keyword letter using the datafile 

addresses , then process the file associated with the keyword memo using the 

datafile of fi ces: 

da t afile addresses 
input "letter filename? " letter 
includefile letter 
datafile offices 
input "memo filename? ", memo 
includefile memo 

If you do not explicitly specify a new datafile, 1st Mail will continue to use 
the last one mentioned until it comes to the end of the file. 

In the previous example we looked at how the inc l udefile command 
works in a command file. However, if the includefile command occurs in 
the middle of a document file, then the document which is processed will be 
included or 'nested' inside the original file. 1st Mail will allow you to nest 
several documents by putting an includefile command in one document 
file, which itself contains an includefile command, and so on: 
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Nested includefile commands are dealt with in the order shown in the 

following diagram. 

FILE A 

FILE B 

includefile B -

~ 
FILE C 

includefile C 
----";;> 

-

1 
In each case, the program will return to the document file or command file 
that the includefile command was in, and carry on where it left off. 
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If, however, you want 1st Mail to switch to processing file B, but not to carry 
on reading through file A afterwards, then use the command chainfile: 

FILE A 

FILE B 

chainfile B 

l 
I 

FINISH 
I 

You can mix includefile and chainfile commands, as long as you 
remember that 1st Mail will return to the original file after an 
includefile command, but not after chainfile: 
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FILE A 

FILE 8 

includefile B 

',-----7 

FILE C 

chainfile C 

-

The commands includefile, chainfile and datafile all require the 

file to be processed to be defined in one of three ways: J 

2 

By specifying the file directly: 

chainfile letter 

By using a keyword which has previously been associated with the file: 

input "letter filename? ", letter 
chainfile letter 

. 3 By not specifying a file; you will then be given a prompt in the 1st Mail 
screen. Specify the file to be chained in exactly the same way as for 
includefile and datafile. 

chainfile 
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Interrupting a command 
file merge 

Comment lines 
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There are certain rules which you must follow if you are using 1st Mail 
commands. For example, commands must always be in light type and at the 
beginning of a line. Any other words in light type will be treated as 
keywords. If you were to put chainfile letter, 1st Mail would look for 

the filename to be substituted for letter before the chainfile command 
was carried out. 

Don't put more than one command on each line, and don't put any text before 
a command. Lines with commands or keywords in them are treated differently 
from lines with text on them. 

Commands in 1st Mail are 'reserved', that is, they must not be used as 
keywords. All the following examples are incorrect, and will cause 1st Mail 
to abort with an error message: 

r e ad name datafile keyword 
Dear Sir read name 
read justify 
display "message" keyword 

(two commands) 
(text before command) 

(command used as keyword) 
(command, then keyword) 

If for any reason you wish to break off a 1st Mail merge procedure which 
includes input commands, click on the 1st Mail window's C lose icon at any 
time during processing; you can do this even when the program is waiting for 
input from you. A dialogue box will appear, asking you whether the merge 
should be abandoned. To stop the sess ion, click on OK; to continue the merge, 
click on Cancel. 

1st Mail will treat a line starting with a light star * (or any other punctuation 
character such as " ! ? : in light type) as a comment. You can use comment 
lines to record notes on how a large or complex command file works. You 
may, for example, want to remind yourself what different datafiles contain: 

datafile address! 
* This file contains clients' addresses 
datafile address2 
* This file contains suppliers' addresses 
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Constructing datafiles 

Separating fields and 
records 

Here are two general rules to remember when you are constructing datafiles: 

• Always keep the fields in the same order in each record . 

• Similarly, ensure that the order of entries in the datafile corresponds to 
the order of the keywords in the read command in the master document. 

If you are using 1st Word Plus to create your datafiles, you will also need to 
remember the following points: 

• Datafiles must be saved in non-WP mode (switch off WP Mode in the 
Edit menu), otherwise formatting characters will create errors in your 
merged documents . 

• Do not put any spaces or a Return at the end of the last line in the 
datafile. (If you use the repeat command in a document, 1st Mail will 

go back to the beginning of the datafile when it co:es across a Return at 
the end of the last record.) 

If you forget these rules and type in your datafile incor ,ectly, you could end 
up with letters that look like this: 

MrA . B Winters Rouse Waken & Co Ltd 
125 King Street 
Ware SG8 6BD 

Dear MrA . B Winters Rouse Waken & Co Ltd 

1 
We are pleased to inform you that 1st Mail is now 
available for use with 1st Word Plus . we l believe that 
many of the customers of 125 King Street will like the 
advanced features ... 

You can see that the fields in the datafile have become out of step with the 
fields in the master document, with very strange results. 

When you create your own datafiles with 1st Word Plus, you must separate 
data fields with commas, and data records with Return. !Datafiles which have 
been produced using some database programs may, hJ wever, use different 
characters to separate fields and records. If this is the case, you may need to 

More about 1st Mail 113 



Enclosing fields 

114 

redefine the characters separating fields and records before reading in the 
datafile concerned. You can redefine field and record separators by using the 
following commands in your master document or command file: 

fieldsep decimal-number 
recordsep decimal-number 

You should replace the decimal-number part of the command by the 
standard ASCII decimal number for the character you want to use. Tables 
showing the complete ASCII character sets available on Acorn computers can 
be found in the User Guide supplied with your computer. Let's say you want to 
use the character # as a record separator. Look up its decimal ASCII number, 

which is 35, and enter the command as: 

recordsep 35 

You can redefine up to 20 different field or record separators at a time. The 
default values for the decimal numbers used with these commands are: 

fieldsep 9,44 (tab, comma) 
recordsep 10,12 (return, form feed) 

Use double (") or single (') quotation marks around fields contammg commas 
to indicate that everything inside them is to be treated • as a single item, 
including the comma but excluding the quotation marks. Don't forget to type 
the quotation mark before the next field separator: 

,"Rouse, Waken & Co Ltd", or 
, ' Rouse , Waken & Co Ltd ', 

1st Mail will read from one quotation mark to the next one it finds of the 
same type, treating everything in between as a single block of data. This 
means that you can enclose one type of quotation mark within the other: 

, "Harry's Bar", 

Since the apostrophe character is the same as the single quotation mark, you 
must enclose the field within double, not single quotation marks if it contains 
an apostrophe. 

If you need to use both single and double quotation marks within your data 
fields, you can define up to 20 new 'quotation mark' characters with the 
command 
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Skipping fields 

- , Empty fields 

quotes decimal-number 

This command works in the same way as fieldsep and recordsep. 

Suppose you have an entry " Harry 1 s Bar " as one of your fields, and you 
want to use the character + to enclose this field . Since its decimal ASCII 
number is 43, enter the command 

quotes 43 

and 1st Mail will read the data field +"Harry 1 s Bar"+ correctly. 

If you do not want to read in all the information contained in each record 
within a datafile, you can use two commas in a row to indicate that a 
particular field in each record must be skipped. You may, for example, have 
a field indicating a person's position in a company: 

Mr,A.B.,Winters,Director, ... Ms,J.C.,Crow,President , 

In order to skip over this particular data field when processing a document, 
enter the read command in the following way: 

read title,initials,narne,, ... 

If you want to skip over the first data field, simply place a comma before the 
first keyword: 

read ,initials,narne, ... 

Similarly, if you want to . skip over more than one data field, simply put in a 
comma for each skipped field. If you want to skip to the start of the next 
record, use the command skiprecord: 

read title,initials,narne,cornpany 
skiprecord 

' Do not insert space(s) if a field is empty, but type the next comma separating 
the fields. For example, if you wanted to add a record to the example 
address list for someone with no known initials, you would enter: 

Mr .,, Daley , 
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1st Mail uses a number of commands which allow you to control the format of 
all or part of any merged documents. Their effect may be modified by any 
rulers embedded in the original document. 

The following pages show the effect of these commands on your documents. In 
each case, the first part of the example shows the commands as you should 
type them in a 1st Word Plus master document. The part after the arrow 
shows the output produced by processing the document with 1st Mail. 

Use doublel ine so that a paragraph (or whole document) will be printed 
with double line spacing when you print it on paper, and singleline to 

revert to single line spacing. 

We are pleased to inform you that 1st Mail , together with 1st 
Word Plus, can handle all your mail merging requirements . 

doubleline 

1st Mail has a powerful set of commands which can be embedded 
in your text to perform useful function, such as printing this 
paragraph in double line spacing . 

s ing l e line 

You can then drop back into single line spacing again 
afterwards, like this . 

We are pleased to inform you that 1st Mail, together with 1st 
Word Plus , can handle all your mail merging requirements . 

1st Mail has a powerful set of commands which can be embedded 

in your text to perform useful function , such as printing this 

paragraph in double line spacing . 

You can then drop back into single line spacing again 
afterwards, like this . 
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Indents Use the indent command to alter the indent value of part or all of a 

document during the mail merge process. You must leave a space between the 
command and the value you supply. The value itself must not be in light text. 

1st Mail can do much more than just help you send the same letter 
to different people (though of course, you can use it for that) . 

indent 20 

1st Mail also allows you to control the layout of your document , 
using embedded commands like this . Notice how this paragraph is 
indented, whereas the first one was not. 

1st Mail can do much more than just help you send the same letter 
to different people (though of course, you can use it for that) . 
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1st Mail also allows you to control the 
layout of your document, using embedded 
commands like this . Notice how this 
paragraph is indented, whereas the first one 
was not . 
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Margins 
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Use the margin command to alter the righthand margin of all or part of a 
document during the mail merge process. 1st Mail will ignore any value of 
margin which is lower than the current indent value eg indent 30, 
margin 20 . You must leave a space between the command and the value 
you supply. 

Of course, indenting is not the only way to change the layout 
of a document in lst Mail . Suppose you want to change the 
righthand margin . 

margin 50 

All you have to do is specify how many columns from the 
lefthand edge of the paper you want the margin to be. And you 
can combine commands to give different effects, 

d o ubl e line 

indent 30 

margin 60 

..... l .ike this, for example . This will print in quite a narrow 
column . 

Of course, indenting is not the only way to c~ange the layout 
of a document in 1st Mail. Suppose you want to change the 
righthand margin. 

All you have to do is specify how many columns from 
the lefthand edge of the paper you want the margin 
to be . And you can combine commands to give 
different effects , 

..... like this, for 

example . This will print 

in quite a narrow column. 
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Ragged text Use ragged to switch off justification when you are printing a document or 
saving it to disc, and justify to revert to justified text. The default setting 

depends on the ruler in your document. 

All the examples so far have had a ragged righthand margin, like 
this paragraph . Whether 1st Mail justifies output documents or not 
depends on any rulers in your original document . The default is to 
leave the document as it was; in other words, that's what it does 
unless you tell it to do something else. 

justify 

Occasionally, though, you'll need to produce documents which 
include justified sections, without worrying about the effects any 
insertion might have when you are mail merging . Use the justify 
command to do this . 

r a gged 

Having turned justification on , you may want to turn it back off 
again : use the ragged command . 

All the examples so far have had a ragged righthand margin , like 
this paragraph . Whether 1st Mail justifies output documents or not 
depends on any rulers in your original document . The default is to 
leave the document as it was; in other words, that ' s what it does 
unless you tell it to do something else . 

Occasionally , though, you' 11 need 
include . justified sections, without 
insertion might have when you are 
command to do this . 

to produce 
worrying about 
mail merging. 

documents which 
the effects any 
Use the justify 

Having turned justification on, you may want to turn it back off 
again : use the ragged command. 
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Miscellaneous topics 

Clearing the screen 

Repeating the merging 
process 

Number of copies 
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Use the clearscreen command to clear the screen of messages at any point 
during the operation of 1st Mail. For example, if clearscreen were to 

come directly before the repeat command in the example master document, 

the screen would be cleared after each successive display of the message 
'PROCESSING YOUR LETTER TO ... '. 

The repeat command tells 1st Mail to repeat the merging process from the 
beginning of the file it is reading. If you do not put a number after repeat, 
your master document will be reprocessed until the end of the datafile is 
reached. However, if you do specify a number, eg repeat 2, the merging 
process will be repeated that number of times, or until the end of the 
datafile is reached (whichever comes first). The program will then either stop 
(if that is the only document being processed), or carry on reading through the 
command file. 

Remember that this number tells 1st Mail the number of times that the 
merging process is to be repeated,· not the total number of copies that you 
will end up with. If you specify repeat 2 , you will end up with three copies. 

1st Mail expects a positive number (1,2, ... ) after the repeat command. To 

merge one copy of a document, do not use repeat 0, but simply omit the 
repeat command. 

Although you are restricted to only one repeat command in each file, you 
can switch to another file with a repeat in it. However, repeat can only 
work with one datafile at a time. This means that you cannot nest datafiles to 
produce, for example, copies of a publicity letter which itself contains a 
current price list of products. If you switch to a new datafile, 1st Mail will 
forget the contents of the old one, and if you r~specify the old datafile, it will 
be read in from its beginning. 

Be careful not to confuse the repeat command with the Number of copies 
option on the Print file dialogue box. Specifying more than one copy to be 
printed will simply tell 1st Mail to go through the merging process that many 
times. If you ask for five copies to be printed, 1st Mail will take you through 
the merging process five times, and any information which was asked for 
during the first copy will also be asked for with each subsequent copy. 
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Page breaks 

Page numbers 

Light type 

Spaces in datafiles 

Inserting the date 

The repeat command will not automatically put in a page break. If you 
want each letter to begin on a new page, you must remember to place a hard 
page break in the page border at the end of your master document and 
before the repeat command, 

The repeat command also does not reset the page number on each copy: if 

you print three copies of a two-page letter, each separate page will be 
numbered consecutively 1 2 3 4 5 6. You can reset the page number on each 
copy by using the pagenum command: pagenum 5, for example, will cause 

each copy of your document to start at page 5. The pagenum command must 

come before repeat. 

1st Mail interprets anything in light type as either a command or a keyword . 
If you use light type for any other reason (eg highlighting words), the 
program will abort with an error message. 

The only exception to this is a light vertical bar I , which will be ignored in 
the text. The light vertical bar can be used to print two separate words with no 
space in between, so that tit 1 e I in it i a 1 s name will appear as: 

MrAB Winters MsJC Crow ctc. 

1st Mail will attempt to interpret any words in light type following a 
command as keywords. For example, repeat 2 would be interpreted as the 

command repeat followed by the keyword 2. 

Spaces in strings (pieces of data read in from a datafile which are more than 
a single word or number long) are treated as soft spaces, and may be 
'stretched' during reformatting by 1st Mail. 

Using your computer's internal clock, you can insert the date automatically 
into your merged documents with a special 1st Mail keyword, rather than 
using an input command and your own keyword. 

1st Mail uses three special keywords for three different ways of writing dates: 

1ongdate 

ukdate 

usdate 
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month in words 

day/month/year 

month/day/year 

eg 19 August 1990 

eg 19/8/90 
eg 08/19/90 
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Printing address labels 
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If 1st Mail comes across one of these special keywords, it will read the 
current date from the operating system and insert it. The current date will be 
inserted beginning at the same position as the keyword used, so allow enough 
space on the right to avoid long dates being 'wrapped' onto the next line. 

One of the many tasks that 1st Mail can be used for is to print addresses on 
sticky labels for envelopes. The following example document created with 1st 
Word Plus - suppli~d on the Program disc as lml_docs .label form -
will print addresses with each first line starting nine lines after the previous 
one: 

You will see that the cursor is on the first line of the document, and that there 
is a short ruler, 21 columns wide, in force at that point. If you are just going to 
print a single column of labels - the sort that come on a roll, for example -
all that matters is that the actual text that replaces the keywords does not run 
over rhe edge of the labels. However, if you are going to print multi-column 
labels, rhe ruler is important, and we will come back to that in a moment. 

Notice the hard page break before the repeat command in the page border. 
This ensures that if any lines are left blank (as a result of omi tblank for 

instance), the next label will still start in the correct position. The soft page 
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Multi-column labels 

break just above will have no effect: it is only displayed because 1st Word 
Plus can't take account of non-printing command lines such as the first two in 
the document. 

Load the example label form into 1st Word Plus and se lect Page Layout 

from the Layout menu. You will see that 

• all the margins have been set to zero 

• there is no text in the headers or footers 

• the page length is set to 9 

• because there are no margins, the number of lines per page is also 9. 

Instead of being on a single roll, your address labels may come on sheets 
with two or three side-by-side. The 1st Mail Print file dialogue box contains 
an option for printing in more than one column; click on the arrows to increase 
or decrease the number. 

When you change the number of columns from its default value of one, you 
will see that the Headers/footers ruler box displays the ruler length and 
pitch. Suppose your document, like label form, has a ruler 21 characters 
long, and you leave the ruler length setting in the 1st Mail Print file dialogue 
box at its default setting of 65. If you choose to print in two columns, 1st Mail 
calculates the gap between columns as 6 5 - ( 21 x 2) = 2 3 . If you print 
in three columns, the gap between columns will be 6 5 - ( 21 x 3) = 1. 

2 

For these calculations, 1st Mail looks at the ruler at the very beginning of the 
document file. Look again at label form: the short ruler extends the whole 
length of the document. What about the read line at the beginning, though, 
which is longer? This looks like a problem, since each command line must be 
a single line with no hard or soft carriage returns in it. The solution is simple: 
trim the main ruler to the length you need for the printed columns, but don't 
reformat any lines containing commands. As for lines containing keywords, 
remember that 1st Mail will do any necessary reformatting for you. 

If your labels come on separate sheets, click on the Pause between pages box 
to enable you to insert a new page. 
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1st Mail commands 

Menu commands 

Info 

Printer 

Quit 

This section describes the 1st Mail icon bar menu options, as well as the 1st 
Mail commands for controlling the appearance of your merged documents. 

Pressing Menu on the 1st Mail icon bar icon displays a menu containing the 
following options. 

Select this option to find out which version of the program you have. You will 
need to supply this information if you ever have to contact your supplier with 
queries about the program. 

This option displays the Printer installation dialogue box. It tells you which 
printer driver is currently installed, and what type of port it will use. 

To install a new printer, open the directory display for the directory 
containing the printer drivers, and drag the icon for the driver you want onto 
the Printer installation dialogue box. Its name will appear in the upper 
white box. 

C lick on the lower box to change the printer port. Use Network Port if you 
are printing across a network such as an Econet, and Parallel or Serial Port if 
you are connecting a printer directly to your computer (for which one to use, 
consult your printer manual; parallel is the most likely). 

Select this option to exit from the 1st Mail program. 
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Text file commands 

Chainfile 

Clearscreen 

Datafile 

Display 

Doubleline 

126 

In the following command descriptions, the command syntax is shown 
alongside the command name. The command name (eg chainfile) should 
be entered in light text. Parameters which are optional are shown enclosed in 
square brackets. When using such a command, do not include the brackets, 
only the parameter. 

c hainfile [filename] 

This command tells 1st Mail to switch to the quoted filename and process it. 
Once 1st Mail has processed that file, it will not return to reading the 
instructions in the original file afterwards. The filename is optional, but if no 
filename is specified in the command, the prompt chain f i 1 e will appear in 
the 1st Mail window to allow you to enter a name. 

clear screen 

This command is used to clear the 1st Mail window. 

datafile [filename] 

This command selects the datafile from which data will subsequently be 
drawn. The filename is optional, but if no filename is specified in the 
command, the prompt datafile will appear in the 1st Mail window to 

allow you to enter a name. 

display "text" 

This command is used to write text to the 1st Mail window. This enables you 
to monitor the progress of your mail merge. 

double line 

Use the command doubleline to switch on double line spacing. 1st Mail 
will default to single line spacing. This command should not be used within a 
paragraph. 
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Fieldsep 

lncludefile 

Indent 

Input 

Justify 

fieldsep decirna1-number,decirna1-number, ... 

This command allows the data input to recognise different field separators, in 
case a non-standard . datafile is used. The decimal number is the ASCII code 
for the desired character. The default decimal values for the number 
following this command are 9 and 44 (tab and comma). 

includefile [filename] 

This command tells 1st Mail to switch to the filename given, and process it. 
Once 1st Mail has processed that file, it will return to reading the instructions 
in the original file. It is possible to nest several includefi~e commands. 
The filename is optional, but if no filename is specified in the command, the 
prompt includefile will appear in the 1st Mail window to allow you to 
enter a name. 

indent position 

Use the indent command to alter the size of the indent for part or all of a 
document during the mail merge process. The size of the indent is measured 
in character spaces. This command should not be used within a paragraph. 

input "prompt", keyword 

This command displays the characters enclosed within the inverted commas on 
the screen and associates the reply which the user types in with the named 
keyword. For neatness in the d isplay window, leave a space after "prompt" , 
since the cursor will be positioned at the closing quotation mark. 

Keywords must be in ordinary type when they are being defined following 
the input command, but in light type when they are being used. 

justify 

Use this command to specify a justified right margin in your merged 
documents. 1st Mail's default setting will depend on any rulers in the 
original document. This command should not be used within a paragraph. 
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Margin 

Noomit 

Omitblank 

Pagenum 

Quotes 

Ragged 
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margin position 

Use the margin command to alter the right margin of all or part of a 
document during the mail merge process. The position of the margin is 
measured in character spaces from the lefthand edge of the page. This 
command should not be used within a paragraph. 

noomit 

This command tells 1st Mail to print blank lines if an empty data fie ld is 
substituted for a keyword. Noomi t is the default setting, but if you have used 
omitblank (see below) and wish to restore blank lines further down your 

document, you will need this command. 

omitblank 

This command te lls 1st Mail not to print blank lines if an empty data field is 
substituted for a keyword. 

pagenum number 

This command resets the page number to the specified value. 

quotes [decimal-number,decimal-number, 0 0 o] 

This command allows the data input to recognise different quotation marks, in 
case a non-standard datafile is used. The decimal number refers to the ASCil 
ode for the character you want. The default decimal values for this command 
are 34 and 39 (single and double quotation marks). 

ragged 

Use the command ragged to specify a ragged right margin in your merged 
documents. 1st Mail 's default setting will depend on any rulers in the 
original document. This command should not be used within a paragraph. 
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Read 

Recordsep 

Repeat 

Setval 

read keyword, keyword, .. 

This command reads one or more fie lds from a datafile and associates them 
with the corresponding keywords. Two consecutive commas can be used to 
indicate that a field must be skipped. If no datafile has been specified, the 
prompt datafile will appear in the 1st Mail window to allow you to enter 

a name. Once defined, keywords can be used in any file processed during a 
1st Mail session. 

Keywords must be in ordinary type when they are being defined following 
the read command, but in light type when they are being used within a 

master document. 

recordsep decimal-number,decimal-number, ... 

This command allows the data input to recognise different record separators, 
in case a non-standard datafile is used. The decimal numbers refer to the 
ASCII codes for the required characters. The default decimal values for this 
command are 10 and 12 (return and form feed). 

repeat [number] 

This command restarts the merging process at the top of the current file. If no 
number is specified, the text file will be repeated until the end of the 
datafile is reached. If a number is specified in the command, the text file 
will be repeated that number of times or unti l the end of the datafile, 
whichever comes fi rst. 

set val keyword, "text" 

There may occas ionally be a piece of text which you would like to be merged 
into documents by 1st Mail, but which (a) cannot be stored in a datafile, and 
(b) you do not want to be entered while the program is running. The set val 
command will insert a piece of text of any length into your documents in 
place of the keyword. You can use this command to insert something like a 
standard warning or copyright notice in all documents merged in a single 
sess ion with 1st Mail, eg: 

setval warning, "Be careful!" 
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Singleline 

Skiprecord 
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setval is identical in use to input, except that the piece of text used with 
setval is typed in before merging, while with input it is typed in during 
the mail merge. 

singleline 

Use the command singleline to revert to single line spacing after using 

the doubleline command. 1st Mail will default to single line spacing if 
neither command is used. This command should not be used within a 
paragraph. 

skiprecord 

This command tells 1st Mail to skip to the start of the next record when 
reading in data . 
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Appendix: Printer .drivers 

Introduction 

Standard printers 

There are hundreds of different printers on the market, and many more on the 
drawing board. Most of these printers claim to be compatible with one of the 
standard printer series (Epson, Diablo and Qume being the most common), 
but many of them are less compatible than they claim, and nearly all of them 
have extra features in addition to the standard ones. 

Despite the lack of true standards, most printers can be used with your Acorn 
computer. 1st Word Plus can drive almost any printer that you can connect to 
your Acorn computer, using a standard subset of the printer's commands. 

In addition to the standard print options, 1st Word Plus also enables you to 
use the full range of your printer's special features, including extended 
character sets, different print styles and pitches (in any combination), and 
even bit-image graphics on a suitable dot matrix printer. 

1st Word Plus is supplied with preconfigured drivers for a range of popular 
printers, which make use of the special functions available. If your printer is 
compatible with one of these configurations, it is very easy to install the 
correct driver for use with 1st Word Plus, and if you wish, to specify it as the 
default driver. For how to do this, see the chapter Printing your document. 

If your printer is not fully compatible with one of the supplied drivers, or if 
you want to use additional features of your printer that are not supported, this 
appendix tells you how to create and install your own custom printer driver 
for use with 1st Word Plus. 

The range of printer drivers supplied w tl vary from country to country, and 
may change as new printers are released onto the market. 

The 1st Word Plus Utilities disc contains a range of preconfigured printer 
files in the directory 1 wp _Print . Con fig, including the following: 
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ASCII 

BROTHER 

BROTH_UK 

DIABLO 

DIABLO_UK 

EPSON_FX 
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This is a universal driver which is compatible with most of the printers 
currently available. It tells 1st Word Plus to print only ASCII characters and 
to remove all style commands - so you won't see bold or underlined text on 
your printout. 

This driver is configured for Brother HR series daisywheel printers HR-15, 
HR-25 and HR-35, but not the HR-1 (use the STANDARD driver). 

The HR-15 accepts commands in 1/120 inch increments, but prints in 1/180 
inch increments, rounding values to the nearest 1/180 inch. This may give 
scruffy results when printing bold text in justified lines, because the 1/120 
inch bold offset will vary between zero and 1/90 inch. Left-aligned headings 
will be unaffected. 

This configuration assumes a standard USA ASCII print wheel (see 
DIABLO). 

The same as the above, but for a UK print wheel. 

This configuration should be used for all Diablo and Diablo-compatible 
daisywheel printers. If you don't know what type of daisywheel configuration 
to use, try this one first . 

As with all daisywheel printers, the characters that your printer is capable of 
printing, and their positions relative to the ASCII code table, depend on the 
print wheel itself. The daisywheel configurations provided with 1st Word 
Plus assume that your printer has a standard USA ASCII daisywheel. You 
will need to create a custom configuration for each non-standard print wheel 1 
that you use. 

The same as the above, but for a UK print wheel. 

If your printer is one of the Epson FX series, or it is described as 'Epson
compatible', this is the driver to use . Epson FX-compatible printers are 9-pin 
draft quality matrix printers supporting the full range of 1st Word Plus 
printing styles, including graphics. 

Not all printers that claim to be 'Epson-compatible' conform to the FX 
standard, including some Epsons! To cause further confusion, the more recent 
FX models (FX-85, FX-105) are in fact Epson LX compatible. 
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EPSON_GQ 

EPSON_JX 

EPSON LX 

EPSON_LQ 

EPSON_RX 

The Epson laser printer. 

The Epson JX series, plus EX models fitted with the colour option, are FX
compatible 9-pin dot matrix colour printers. 

The ]X driver is configured to print in red ink when it detects the light text 
style and to reproduce colour graphics in up to eight colours (red, green, blue, 
cyan, magenta, yellow, black and white). Pictures are stored as sprites. If a 
palette has been stored with the sprite, the printer will attempt to match the 
palette colours to the nearest print colour available. If no palette has been 
stored with the sprite, the standard 1st Word Plus palette will be used. 

The Epson LX and GX series, together with the FX-85 and FX-05, are 9-pin 
matrix printers that have an extra NLQ (near-letter-quality) mode in addition 
to the standard FX features. 

The NLQ mode on these printers is only available for use with Pica pitch (10 
characters per inch) and does not support italic, superscript or subscript 
characters. To overcome this, the supplied LX driver switches NLQ mode on 
and off as required to reproduce the screen appearance as closely as 
possible. However, this has some unavoidable side effects in NLQ printing, 
and you should not use the following styles combined with light face in NLQ 
mode: 

• italic 

• superscript 

• subscript 

When printing in draft mode, none of these restrictions apply. 

The Epson LQ and SQ range are very high quality 24-pin matrix printers that 
have an excellent NLQ mode without any of the restrictions of the LX series. 

These printers are FX-compatible in every respect except graphics, which will 
be printed some 30% larger than on an FX series printer. 

The Epson RX printer and compatibles. 
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IBM_GRAP 

IBM_PROP 

JUKI 

JUKI_UK 

QUME 

QUME_UK 

STANDARD 
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The IBM Personal Graphics Printer is a 9-pin dot matrix printer, loosely 
based on the Epson FX-80 command set, with draft mode text printing and bit
image graphics printing modes. 

The IBM Proprinter is a 9-pin dot matrix printer, loosely based on the Epson 
FX-80 command set. The Proprinter has draft, double-strike NLQ and bit
image graphics printing modes. 

This configuration supports the JUKI 6100 range of daisywheel printers. 

This configuration assumes a standard USA ASCII print wheel (see 
DIABLO). 

As above, but for a UK print wheel. 

This configuration supports the Qume Sprint range of daisywheel printers, 
models 5, 9 and 11 , but excluding the Sprint 10 (for which you should use the 
STANDARD configuration). 

This configuration assumes a standard USA ASCII print wheel (see 
DIABLO). 

As above, but for a UK print wheel. 

To get you started, this driver is installed as the default 1st W ord Plus 
printer. Although it has a restricted range of functions, it is compatible with 
practically all printers, ranging from a simple teletype to a laser printer. The 
minimum requirement is the presence of a backspace function on the printer. 

The STANDARD driver prints only ASCII 
commands except bold and underline, 
backspacing and overprinting. 

characters and removes all style 
which are implemented by 
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Custom printer 
configuration 

Types of printer 

The following pages describe the process of preparing and converting a 
custom printer configuration to utilise the special features of your printer. 

Creating a custom printer configuration requires great attention to detail and a 
degree of trial and error. Computer novices are advised to use one of the 
standard configurations. However, if you are confident that you understand the 
principles involved and you follow these procedures exactly, you can create a 
driver that matches your printer. 

1st Word Plus recognises three basic types of printer: 

• DAISY 

• 

These are daisywheel printers capable of 
inch) with a print wheel of 96 (or more) 
Word Plus drives daisywheel printers 
control to control print styles such as 
underlining. 

microspacing (usually to 1/120 
characters in a single font. 1st 
directly under microspacing 

character pitch, boldface and 

If you use one or more non-standard print wheels, you will need to 
configure a special printer driver for each print wheel, to ensure that your 
screen display matches the printed output. 

Proportional spacing is not available using a microspacing daisywheel 
configuration. If your printer supports proportional spacing and you wish 
to use this feature, make a custom driver based on a matrix printer 
configuration, using the printer to achieve bold, underlining, etc. 

MATRIX 

These are 9- and 24-pin dot matrix printers, with a range of print styles 
and fonts. 1st Word Plus uses the built-in features of these printers to 

produce the different style effects, sending escape sequences for each 
style or font change. 

A proportional spacing driver can be configured if a proportional font is 
available on the printer. However, this mode cannot support justified text. 

• STANDARD 

---, Some printers (including most typewriters with computer interfaces) are 
incapable of microspacing control and have a very limited or extremely 

!"'J complicated command set. 1st Word Plus utilises the backspace function 
(when available) to implement boldface and underlining only. 
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Some notes on printer 
hardware 

Editing configuration 
files 

Source files 
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When producing a configuration for a printer, you may also have to configure 
the printer hardware. 

Most printers have sets of 'DIP' switches which affect things such as auto
linefeed or paper length. Most of these can be set to your preferred options, 
except the following: 

• Skip over perforation must be DISABLED. 

• Auto linefeed after carriage return must be DISABLED. 

and, for a serial interface: 

• CTS/RTS handshaking must be ENABLED. 

• XON/XOFF handshaking must be DISABLED. 

For 'Epson-compatible' matrix printers it is not necessary to switch language 
fonts, and you should use the standard USA setting. The printer driver is 
configured to switch fonts under software control to access accented characters. 

With daisywheel printers, the character translation table in the printer 
configuration must be changed to match your print wheel if this is not 
standard USA ASCII. 

In the lwp _Print. Source directory on the Utilities disc you will find 
three files corresponding to the three basic printer types: 

• DAISY 

• MATRIX 

• STANDARD 

Use 1st Word Plus to create a custom printer configuration by editing the file 
which is appropriate to your printer. Make sure that WP mode in the Edit 
menu is switched off when editing, and give your printer file a new name 
when you save it. 

Most of the data in the printer file is numeric, and numbers are assumed to 
be in hexadecimal. Lines starting with asterisks are comments; blank lines are 
ignored. The data held in the file falls into four sections, described below. 
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Printer name 

Configuration variables 

. -, 

The first non-blank line in the file (excluding comments) is assumed to be the 
name of the printer. When the printer driver is installed, this name appears 
on the 1st Word Plus keypad. The name should not exceed 32 characters. 

This section contains a list of six numbers (on a line together) separated by 
commas, as follows: 

1 Printer type 

This should be set to 1 for a microspacing daisywheel printer, otherwise 
zero. 

2 Unit width 

For a daisywheel printer, this specifies the width of one character in the 
printer's own width units. 

For a matrix printer, this value should be set to 2 if each pixel is tO be 
printed twice (to double the output width) in graphics mode (Atari 
SMM804). 

3 Unit height 

This specifies the size of a linefeed in the printer's own height units. 

4 Middle of carriage/graphics resolution 

5 

For a daisywheel printer, this specifies the position to which the print 
head should be moved when feeding paper (normally the middle of the 
paper). This position is specified in printer units from the lefthand 
margin. 

For a matrix printer, this specifies the printer graphics resolution in 
pixels per inch. It is used for the screen display of a box around the 
picture to show its actual size on paper. 

Carriage shift for bold (daisywheel only) 

This specifies the horizontal offset in printer units used by the printer 
driver when printing bold text: it prints the character once, moves along a 
fraction, and prints again. 

6 Pause between pages 

Set this to 1 to force the printer driver to pause at the end of each page to 
allow the paper to be changed, otherwise zero . 
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This is a table of command sequences which are sent to the printer for style 
changes, etc. The first number on each line is the function number used to 

identify the line (this is not sent to the printer). The entries in the table must 
be in increasing order of function number, but it is not necessary for all the 
entries to be present. 

Each table entry starts with its entry number, followed by the codes to be sent 
to the printer, separated by commas. A comment may be included on the line, 
preceded by an asterisk. 

A value more than 80 (he:c) is a placeholder for variable binary information 
to be sent to the printer: the difference after subtracting 80 is added to the 
value to be output. For example, on a Diablo-compatible printer, commands 
to control character width require a value to be output of width+ 1, so the 
placeholder in the command is 81. 

The table is terminated by a zero entry, but there must be at least one non
zero entry before this. 

In addition to the initialisation strings listed below, the printer driver also 
sends all commands which turn off print styles at the start of each document. j 

When printing in NLQ mode, if a style change command for NLQ mode is 
not present, the corresponding Draft mode command will be used instead. 

You do not have to include all the following commands for your printer. 
Where you wish to omit a command, it is simpler to do this by making the 
entry a comment line by typing an asterisk at the start of the line. 

Remember that these commands must be kept in numerical order, and that all 
entries are in hexadecimal. 

0 Set character width (daisywheel only) 

This command sends character width changes to the printer. It includes a 
placeholder for the width (normally 81 ). 

1 Linefeed 

This command contains the code to be sent to the printer at the end of a 
line. This is normally a linefeed for daisywheel printers, and a linefeed 
plus carriage return for dot matrix printers. 

2 Forward print (daisywheel only) 

This instructs the printer to print from left to right. 
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3 Backward print (daisywheel only) 

This instructs the printer to print from right to left. This command should 
be omitted for those 'intelligent' daisywheel typewriters which cannot 
print bidirectionally (for example, J uki 2200 and Brother CE-51). 

4 Vertical tab (optional) 

This command feeds the paper by several lines in a single smooth 
operation. The command should include a placeholder for the line 
number. If this command sequence is omitted from the table, several 
linefeeds will be used instead. 

There is a potential problem when using vertical tabs on some printers. If 
you have a document with lines longer than the paper width, imd the 
printer automatically wraps lines which are too long, this may cause the 
printer's line number to get out of step with the program's line number. 
Vertical tabs would then typically skip to the start of the next page. 

5 Absolute horizontal tab (non-daisywheel) 

6 

This command is the horizontal equivalent of the above: it moves the print 
head horizontally to a specified character position. 

Draft bold on 

This command sequence instructs the printer to switch on draft bold 
printing, using either emphasised or double-strike modes (or both). 

If this command is defined for a daisywheel printer, the printer will 
effect the style change, otherwise the software will achieve this by 
microspacing and overstrike. If this command is omitted for a non-daisy 
printer and a backspace command is defined, then bold text will be 
printed using backspace and overstrike. 

7 Draft bold off 

8 

This command sequence instructs the printer to switch off draft bold 
printing. 

NLQ bold on 

This command is similar to (6), but operates in NLQ mode. 

If your printer does not support NLQ printing, you can omit all the NLQ 
commands. 
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9 NLQ bold off 

This should switch off bold and ensure that the printer remains in NLQ 
mode. 

A Draft italic on 

This command instructs the printer to switch on italic printing. 

B Draft italic off 

This command instructs the printer to switch off italic printing. 

C NLQ italic on 

This command instructs the printer to switch on italic printing in NLQ 
mode. 

Some printers (Epson LX-80 etc) cannot print italic in NLQ mode. In this 
case use this command to switch off NLQ then switch on double-strike and 
italic! 

D NLQ italic off 

This command instructs the printer to switch off italic printing in NLQ 
mode. 

If you have switched off NLQ mode to print italic, you will need to switch 
it back on here. 

E Draft light on 

If your printer has a second colour ribbon, use this command to switch 
ribbons, otherwise omit the command. 

F Draft light off 

If you use light to switch to a second colour, use this to switch back to 
black, otherwise omit the command. 

10 NLQ light on 

Use this command to switch out of NLQ into draft mode to give the effect 
of a lighter face. 

11 NLQ light off 

Switch NLQ back on again. 

12 Draft superscript on 

For dot matrix printers, this command instructs the printer to switch on 
superscript style. 

Appendix: Printer drivers 



-

-

For daisywheel printers, this command (usually) performs a reverse half 
linefeed. 

13 Draft superscript off 

For dot matrix printers, this command instructs the printer to switch off 
superscript style. 

For daisywheel printers, this command (usually) performs a half 
linefeed. 

14 NLQ superscript on 

For certain NLQ dot matrix printers (Epson LX-80 etc) you may need to 
switch off NLQ in order to print superscript. Otherwise, the command is 
identical to (12) above. 

15 NLQ superscript off 

If you have switched off NLQ to print superscript, you will need to switch 
it back on here. Otherwise, the command is identical to ( 13) above. 

16 Draft subscript on 

For dot matrix printers, this command instructs the printer to switch on 
subscript style. 

For daisywheel printers, this command (usually) performs a half 
linefeed. 

17 Draft subscript off 

For dot matrix printers, this command instructs the printer to switch off 
subscript style. 

For daisywheel printers, this command (usually) performs a reverse half 
linefeed. 

18 NLQ subscript on 

For certain NLQ dot matrix printers (Epson LX-80 etc) you may need to 
switch off NLQ in order to print subscript. Otherwise, the command is 
identical to (16) above. 

19 NLQ Subscript Off 

If you have switched off NLQ to print subscript, you will need to switch it 
back on here. Otherwise, the command is identical to (17) above. 
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IA Draft underline on 

This command sequence instructs the printer to switch on draft underline 
printing. 

If this command is defined for a daisywheel printer, the printer will 
control underlining. Most daisywheel printers are not intelligent enough 
to underline correctly in microspaced lines. They will either cheat (by not 
underlining spaces), or will go wrong under certain conditions! It is safer 
to let 1st Word Plus control underlining. 

If this command is omitted for a daisywheel printer, underlines will be 
printed by 1st Word Plus during a second pass of the line. 

If this command is omitted for a non-daisywheel printer and a backspace 
command is defined, underlining will be printed by backspace and 
overstrike. 

IB Draft underline off 

If you have included an 'underline-on' command, use this to switch it off 
again. Otherwise, omit the command. 

I C NLQ underline on 

If your printer supports NLQ, this should be identical to lA. Otherwise, 
omit the command. 

I D NLQ underline off 

If your printer supports NLQ, this should be identical to 1 B. Otherwise, 
omit the command. 

IE Formfeed (optional) 

If this code is defined, it is used to feed the paper to the top of the next 
sheet. Otherwise, linefeeds will be used. 

IF Horizontal initialisation (optional) 

This code is sent once only at the start of the document. 

For a daisywheel printer, this should include a character width command 
whose placeholder will be replaced by the default character width from 
2 above. 

20 Vertical initialisation (optional) 

This code is sent once only at the start of the document. 
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For a daisywheel pril!ter, this should include a linefeed distance 
command whose placeholder will be replaced by the default line height 
from 3 above. 

You can include a form feed in this initialisation string to ensure that the 
printer is at the start of a page when you print a document. 

21 Printer reset (optional) 

This command is sent to the printer at the end of the document to reset it 
for use by other programs. 

22 Backspace 

If this command is defined for a non-daisywheel printer, and there is no 
underline command, underlines will be printed by backspace and 
overstrike. Similarly, if there is no bold command, backspace overstrike 
will be used for bold text. 

23 Carriage return 

This command should contain a carriage return (without a linefeed) for 
use when printing graphics. It will also be used by non-bidirectional 
daisywheel printers. 

24 Form length in lines 

If this command is defined, it will be output at the start of the document 
to set the printer's form length to the value on the Page Layout dialogue 
box. This will prevent the printer from automatically starting a new page 
before the end of another. · 

25 Set linefeed distance 

This command is required for graphics output, to control the size of a 
linefeed. It should contain a placeholder for the linefeed distance. 

26 Print graphics 

This command is used to start a line contammg graphics data. The 
command is followed by two bytes giving the byte count of the following 
graphics data (Epson-style). 

27 Reserved 

Command 27 is not used; it is reserved for future expansion. 
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28 Draft Pica 

On a dot matrix printer, this command is used to switch into Pica pitch (10 
characters per inch (cpi)) in draft mode. It should also switch off double
width and condensed printing. 

On a daisywheel printer, this should contain a single value giving the 
character width in the printer's internal units (usually C). 

29 NLQ Pica 

This command is used to switch into Pica pitch (10 cpi) in NLQ mode. 
This is usually identical to 28, but must additionally switch NLQ on if the 
printer does not support NLQ with other pitches (Epson LX-80 etc). 

This is not used on a daisywheel printer. 

2A Draft Elite 

On a dot matrix printer, this command is used to switch into Elite pitch 
( 12 cpi) in draft mode. This command should also switch off double
width and condensed printing. 

On a daisywheel printer, this should contain a single value giving the 
character width in the printer's internal units (usually A). 

2B NLQ Elite 

This command is used to switch into Elite pitch (12 cpi) in NLQ mode. 
This is usually identical to (2A), but should be omitted entirely for 
printers that cannot print NLQ Elite, such as the Epson LX-80. 

This is not used on a daisywheel printer. 

2C Draft Condensed 

On a dot matrix printer, this command is used to switch into Condensed 
pitch (usually 17.2 cpi) in draft mode. It should also switch off double
width printing. 

On a daisywheel printer, this should contain a single value giving the 
character width in the printer's internal units (usually 8 for 15 cpi). 

2D NLQ Condensed 

This command is used to switch to condensed pitch (normally Condensed 
Pica for 17.2 cpi) in NLQ mode. This is usually identical to (2C), but 
should be omitted entirely for printers that cannot print NLQ Condensed, 
such as the Epson LX-80. 

This is not used on a daisywheel printer. 
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Character translation 
table 

2E Draft Expanded 

On a dot matrix printer, this command is used to switch into Expanded 
pitch (normally double width Elite for 6 cpi) in draft mode. It should 
also switch off Condensed mode printing. 

On a daisywheel printer, this should contain a single value giving the 
character width in the printer's internal units (usually F for 8 cpi). 

2F NLQ Expanded 

This command is used to switch into Expanded pitch (normally double
width Elite for 6 cpi) in NLQ mode. This is usually identical to (2E), but 
should be omitted entirely for printers that cannot print NLQ Expanded, 
such as the Epson LX-80. 

This is not used on a daisywheel printer. 

30 Black ink 

This command is used to switch to black ink when printing graphics on a 
colour printer. Otherwise, omit the command. 

31 Magenta ink 

This command is used to switch to magenta ink when printing graphics on 
a colour printer. Otherwise, omit the command. 

32 Cyan ink 

This command is used to switch to cyan ink when printing graphics on a 
colour printer. Otherwise, omit the command. 

33 Yellow ink 

This command is used to switch to yellow ink when printing graphics on a 
colour printer. Otherwise, omit the command. 

This table must be configured to translate each character into one or more 
codes, to access the nearest equivalent character on your printer. 

The character translation table is held in Acorn character code order, 
terminated by a zero entry. Each entry comprises the Acorn code followed by 
zero or more codes to be sent to the printer, separated by commas and 
followed, optionally, by an asterisk introducting a comment. 
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If you configure your matrix printer to use the standard USA font, or use a 
standard USA ASCII daisywheel, then the code range 20-7F (hex) of the 
Latin Alphabet 1 character set (ECMA/ISO) can be sent directly to the 
printer without translation. There need not be any table entries for standard 
USA ASCII characters. 

If you are using a UK ASCII font or daisywheel, you will need to translate 
both the £ and # characters to produce correct results on the printer. 

Accented characters and other international characters in the second half of 
the character set can be printed on some printers either by backspace and 
overstrike or by sending commands to the printer to switch font. In this case 
the table entry should start with the code of the character to be translated, 
followed by the data to be sent to the printer. 

Where a character cannot be satisfactorily printed, a table entry gtvmg just 
the character code without any translation will cause the printer driver to skip 
that character. 

See the MATRIX file for font switch commands to access accented characters 
(it switches back to the USA font for standard USA ASCII symbols). 

See the DAISY file for accented characters on a daisywheel printer achieved 
by backspace and overstrike. This table will · need changing for different 
daisywheels! 

There is no fixed limit on the size of the table, so adventurous installers could 
try including commands to download character shapes into dot matrix printers 
for some of the more exotic characters. 

1st Word Plus prints graphics images pixel-for-pixel as shown on the screen, 
without any scaling or raster transformation. Thus the screen representation of 
the image in relation to the text will be an approximation to the printed 
output. 

If you have a graphics printer driver installed, each image displayed on the 
screen is bordered by a dashed line indicating the extent of the image on the 
printed page. This helps you align your text with the graphics image. 
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Unit height 

Unit width 

Graphics resolution 

Aspect ratio 

In practice, most Epson-compatible printers will print graphics exactly as 
shown on the screen, with no relative size change. 

1st Word Plus supports colour printers with four-colour ribbons (Epson JX-
80, etc). See above under the appropriate printer name in the Standard printers 
section for further details. 

The unit height (3) must be set to the spacing between lines in intemal units. 
Most Epson-compatible printers have 72 dots per inch, and print six lines per 
inch, so the lines are 12 dots apart. The Epson LQ-800 has 60 dots per inch in 
8-pin mode, so the line spacing is set to 10 for this printer. · 

If the unit width (2) is set to 2, then the picture will be expanded to double 
width by sending each pixel twice. 

This is useful for printers such as the Atari SMM804 which only has a high
density graphics mode (1280 dots to 8 inches, but adjacent dots are not 
printed). 

If the unit width is set to 0 or 1 then the graphics will not be expanded in this 
way. 

The x-axis graphics resolution (in pixels per inch) is held in the Configuration 
Variables (see above). This is used for calculating the effective picture width 
when displaying the picture border on the screen. If the unit width is set to 2 
to double the width of the picture, this number should be halved to match. 

If printing on an Epson FX-80, mode 5 (lB, 2A, 5) will produce a square 
aspect ratio (circles are actually circular). However, some 'Epson-compatible' 
printers do not support mode 5. 

Epson mode 4 (1 B, 2A, 4) will print a full screen snapshot on 8 inch paper, 
but will produce slightly elliptical circles. 

On an Epson LQ-800 or similar, use mode 0 (lB, 2A, 0) for a square aspect 
ratio. This will expand the picture by some 30%, as indicated on screen by the 
picture border. 
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Converting your custom 
driver 

The 1 stConvrt program 

148 

Graphics colour printing is 'subtractive' and therefore requires 
magenta, cyan and yellow ink to achieve black, red and green printing. 
subtraction is carried out automatically by the printer driver. 

black, 
Colour 

If you print a colour picture on a monochrome printer, the printer driver will 
automatically convert the colours into an approximate grey-scale 
representation. 

To prepare your custom driver for operation with 1st Word Plus, it is first 
necessary to convert the hex printer file into a file of type lWPCfg - the 
format that 1st Word Plus understands. 

To do this, use the lstConvrt program, which you will find on the Utilities 
disc. When you double-click on its icon, the program will run immediately 
(rather than appearing on the icon bar), and the following window will 
appear: 

1st Install 
~ Dr~g a file of 
E!:J this type to 
this window or enter 
a filena~e below. 

I Cancel II OK 

Drag the file you have edited onto the window, and its name will appear in 
the box. When you click on OK, the normal Save as dialogue box will 
appear, but the icon will be that for a configuration file instead of a text file. 
Enter the filename you wish to give to your printer driver and drag the icon to 
the directory where you want to keep the file. 
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Testing the configuration 
file 

When you have performed one conversion, the program will run again, 
displaying the dialogue box for the source file. If you want to convert another 
source file, repeat the process. Otherwise, click on Cancel and the program 
will stop. 

You can test your new configuration file using the file lwp_docs. 

printtest (on the Program disc), which includes examples of all of the 
possible print pitches and character styles, a character set table, and a 
graphics image. Print this file to test your new printer configuration. 
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End~user licence conditions for 1st Word Plus 
(Release 2) 

1. Definitions 

2. Licence 

The following expressions have the meanings given here: 

'Acorn' means Acorn Computers Limited, being either owner of all 
intellectual property rights in the Software, or having the right to grant 
licences of the Software. 

'Developer' means any third party software developer who retains copyright 
in the Software. 

'Documentation' means the printed user documentation supplied with the 
Software inside the pack. 

'Software' means the programs contained in object-code form on the disc(s) 
supplied with these conditions: 

Acorn grants you a personal non-transferable non-exclusive licence (or sub
licence), as follows: 

( 1) You may copy the Software for backup purposes, to support its use on 
one stand-alone Acorn computer system. (Separate provision for site 
licences is made on form APP157 available from your Acorn Authorised 
Dealer.) 

(2) You must ensure that the copyright notices contained m the Software are 
reproduced and included in any copy of the Software. 

(3) You may not: 

(i) copy only part of the Software; or 

(ii) make the Software or the Documentation available to any third 

(iii) 

(iv) 

party by way of gift or loan or hire; 

incorporate any part of the Software into other programs 
developed or used by you; or I 

copy the Documentation. 
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3. Term 

4. Limited warranty and 
disclaimer of liability 

5. General 
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This licence remains in effect unless you terminate it: 

( 1) by destroying the Software and all copies, and the Documentation, or 

(2) by failing to comply with the Conditions. 

(1) Acorn warrants the disc(s) upon which the Software is supplied to be free 
from defects in materials and workmanship under normal use for a 
period of ninety (90) days from the date of purchase, as evidenced by a 
copy of your receipt. Your Acorn Authorised Dealer will replace a 
defective disc if returned within ninety (90) days of purchase. 

(2) The Software is supplied 'as is'; neither Acorn nor the Developer makes 
any warranty, whether express or implied, as to the merchantability of the 
Software or its fitness for any particular purpose. 

(3) In no circumstances will Acorn be liable for any damage, loss of profits, 
goodwill or for any indirect or consequential loss arising out of your use 
of the Software, or inability to use the Software, even if Acorn has been 
advised of the possibility of such loss. 

These conditions supersede any prior agreement, oral or written, between you 
and Acorn relating to the Software. 



Index 

Numerics 

1st Mail 4, 91-130 
icon bar menu 125 
installing printer 93-94, 125 
quitting 125 
see also mail merge 

1st Word Plus 
loading 19 
quitting 23 
Release 1 4-5 

1stChars 53 
1st0Merge 51-52 

A 

Acorn Desktop Publisher 24 

B 

block see selection 
bold text 10 
bookmarks 30, 81 
browser 50, 87 

c 
capital letters, typing in 11 
case sensitivity 37, 38 
case, upper and lower 74, 86 
centred text 10, 65 

Index 

character spacing 63-64 
characters, accented 53 
clipboard 16, 29 
command files (1st Mail) 105-112 

comment lines 112 
preparing 112 

commands (1st Mail) 98, 99-102, 
106-112 

chainfile 110-111,126 
clearscreen 120, 126 
datafile 106, 126 
display 102, 126 
doubleline 116, 126 
fieldsep 127 
includefile 107-111, 127 
indent 117, 127 
input 106-107, 127 
justify 119, 127 
margin 118, 128 
noomit 128 
omitblank 101, 128 
pagenum 128 
quotes 128 
ragged 100, 119, 128 
read 100, 129 
recordsep 129 
repeat 102, 120, 129 
setval 129 
singleline 116, 130 
skiprecord 130 

corrections, making 10, 14 

153 



154 

cursor 10 
moving 13, 26-27, 82 

customisation 6 

D 
datafile (1st Mail) 95-96, 103, 113-

115 
empty fields 115 
enclosing fields 114-115 
separating fields 113-114 
skipping fields 115 
spaces in 121 

deleting text 27, 29 
dictionaries, merging 51-52 
dictionary file type 4 7 
dictionary, main 

adding words 51 
deleting words 51 
loading 47, 86 

dictionary, supplementary 22 
adding words 48-50, 87 
deleting words 51 
loading 47 
saving 51, 88 

directory display, opening 7 
discs, working copies of 5 
document 

loading 20 
merging 28 
moving around in 26 

document size 23 
in words 81 

document window 7-8, 20, 20-21, 26 

F 

field 103 
footer see headers and footers 

footnote 31-36 
adding 31, 85 
deleting 32 
editing 31 
effect on page break 36 
format 35, 85 
layout 33-34 
number 33 
number sequence 32 
printing position 33 
ruler line 32 
separator 34-36 
window 31-32 

function keys 21 

G 

graphics mode 44, 88 

H 

hard disc 5 
header see headers and footers 
headers and footers 56, 57-58, 84 

different left and right 77 
ruler 58 
text 58 

help, how to get 18, 88 
hyphenation 41, 66-67, 81 

I 

indent, hanging 68 
indenting 14, 43, 67-69 

line 67 
paragraph 68 

insert mode 2 7, 81 
italic text 12, 74 

Index 



J 
justification 41, 64-65 

K 

keyboard 22 
keypad window 8-9, 21 
keystroke equivalents 7, 89-90 
keywords (1st Mail) 98-99, 106 

L 

layout, saving 62 
left-aligned text see ragged text 
licence conditions, end-user 151-152 
line spacing 41, 66 
line, moving to 82 
lines per page 57 
loading 

M 

1st Mail 93 
1st Word Plus 7, 19 
document 20 

mail merge 
address labels 122-123 
example session 96-98 
formatting of output 116-119 
inserting date 121 
interrupting 112 
multi-column printing 123 
number of copies 120 
page breaks 102, 121 
page numbering 121 
repeating 120 

margin 55 

Index 

alternate left 77 
bottom 57 

foot 56, 58 
head 56,58 
left/right see ruler 
printing 77 
top 56 

markers see bookmarks 
master document (1st Mail) 94-95 
memory limitations 23 
menus, how to use 9, 17, 79-80 
modules, relocatable 4 
monitors 6 

0 

overwrite mode 27-28, 81 
overwriting existing file 6 

p 

page border 21, 36, 70, 71 
page break 41, 70-72 

1st Mail 102,121 
conditional 71-72 
hard 71 
soft 70 

page number 58 
offset 77 

page, moving to 41, 82 
pages, number in document 81 
paper length 55- 56 
paragraph, numbered 69 
pictures 44-46 

deleting 45-46, 88 
loading 44 
moving 45 
printing size of 45 

pitch 41, 60, 63-64 
pointer shape 15, 45, 71 

155 



156 

position in document 
displaying 84 
finding 40-41 

print quality, NLQ 77 
printer driver 22, 75-76, 131-149 

ASCII 132 
Brother 132 
converting 148-149 
customising 135-146 
default 75 
default, changing 76 
Diablo 132 
Epson 132-133 
graphics 146-148 
IBM 134 
installing 75-76,93-94, 125 
Juki 134 
Qume 134 
standard 131-134 
test file 149 

printer port 76, 93, 125 
printing 75-78 

interrupting 78 

Q 

pause between pages 78 
starting 78 

quitting 1st Mail 125 
quitting 1st Word Plus 23 

R 
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of word not in document 87 
whole document 48, 87 
see also dictionaries 
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tab 62-63 
decimal 63 
leader character 62 
left-aligned 62 
right-aligned 63 

text files 

u 

importing 43-44 
loading 6 

underlining 11, 73-74 

w 
word processing mode see WP mode 
word wrap 12, 41, 65 ,81 
WP mode 40, 41, 42, 81, 84 

Index 157 



158 Index 



1 
1

s
t W

O
R

D
 
P

L
U

S
'" 

. 
-
-
-
-
-
-
-
-
-

(R
E

L
E

A
S

E
 
2

) 


